
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ОСНОВИ РАЧУНАРСКЕ ТЕХНИКЕ И 
ПРОГРАМИРАЊА 

 
Практикум за лабораторијске вежбе 

 
 
 
 
 
 
 
 
 
 
     Студент:           ________________________ 
 
     Индекс број:     ______________ 
 
 
 
 
 
 
 
 
 
 
 

Висока техничка школа струковних студија 
Звечан, 2014. 

 



Садржај 
 
 
 
 
ПППрррееедддгггооовввоооррр...................................................................................................................... 4 
 
ОООссснннооовввеее   ииинннфффооорррмммаааццциииоооннниииххх   тттееехххнннооолллооогггииијјјааа ......................................................................... 9 

Вежба бр. 1 ................................................................................................................ 9 
Појам и структура информационих система:Хардвер и Софтвер ...................... 9 
Одговори на питања: ........................................................................................... 13 

 
ОООпппееерррааатттииивввннниии   сссиииссстттеееммм   рррааачччууунннааарррааа   –––   WWWiiinnndddooowwwsss   XXXPPP ......................................................... 15 

Вежба бр. 2 .............................................................................................................. 15 
Основни појмови и подешавања, рад са прозорима ......................................... 15 
Уради Вежбу: ........................................................................................................ 23 

Вежба бр. 3 .............................................................................................................. 24 
Рад са датотекама и фасциклама, претрага садржаја,Windows Explorer ........ 24 
Уради Вежбу: ........................................................................................................ 27 
Одговори на питања: ........................................................................................... 28 

 
ПППрррооогггррраааммм   зззааа   оообббрррааадддууу   тттееекккссстттааа   –––   WWWooorrrddd ........................................................................... 31 

Вежба бр. 4 .............................................................................................................. 31 
Word, основни појмови, рад са документом ....................................................... 31 
Уради Вежбу: ........................................................................................................ 36 

Вежба бр. 5 .............................................................................................................. 37 
Начин приказивања документа, унос, означавање и брисање текста ............. 37 
Уради Вежбу: ........................................................................................................ 40 

Вежба бр.6 ............................................................................................................... 41 
Форматизација текста,  подешавање фонтова и параграфа ............................ 41 
Уради Вежбу: ........................................................................................................ 44 

Вежба бр.7 ............................................................................................................... 45 
Рад са листама набрајања, убацивање графичких објеката у текст ............... 45 
Уради Вежбу: ........................................................................................................ 49 

Вежба бр.8 ............................................................................................................... 50 
Рад са табелама у Word-овом документу .......................................................... 50 
Уради Вежбу: ........................................................................................................ 53 

Вежба бр.9 ............................................................................................................... 54 
Припрема за штампу: маргине, нумерација страна, заглавље                                  
и подножје, прелом стране .................................................................................. 54 
Уради Вежбу: ........................................................................................................ 57 
Одговори на питања: ........................................................................................... 58 

 
ПППрррооогггррраааммм   зззааа   тттааабббееелллааарррнннеее   пппрррооорррааачччууунннеее   –––   EEExxxccceeelll ............................................................... 61 

Вежба бр.10 ............................................................................................................. 61 
Основни елементи, унос и измена података,  аутоматско                            
попуњавање - серије и листе .............................................................................. 61 
Уради Вежбу: ........................................................................................................ 67 

Вежба бр.11 ............................................................................................................. 68 
Форматирање садржаја ћелије, промена ширине колоне и висине реда, ....... 68 
Уради Вежбу: ........................................................................................................ 70 



 

 

Вежба бр.12 ............................................................................................................. 71 
Израда и уређење дијаграма (графикона) ......................................................... 71 
Уради Вежбу: ........................................................................................................ 74 

Вежба бр.13 ............................................................................................................. 75 
Рад са формулама и функцијама,обрада података у табели .......................... 75 
Уради Вежбу: ........................................................................................................ 78 
Одговори на питања: ........................................................................................... 80 

 
МММрррееежжжеее   иии   ИИИнннтттееерррнннеееттт .................................................................................................... 83 

Вежба бр.14 ............................................................................................................. 84 
Основне услуге Interneta, Internet Explorer, претраживање података, ............. 84 
Уради Вежбу: ........................................................................................................ 88 
Одговори на питања: ........................................................................................... 88 

Вежба бр.15 ............................................................................................................. 90 
Eлектронска пошта, Outlook Express .................................................................. 90 
Уради Вежбу: ........................................................... Error! Bookmark not defined. 
Одговори на питања: ........................................................................................... 93 

 
ЛЛЛииитттееерррааатттууурррааа ................................................................... Error! Bookmark not defined. 
 

 
 
 



 

 

ПППрррееедддгггооовввоооррр   
   

Практикум за лабораторијске бежбе из предмета Основи рачунарске технике и 
програмирања урађен је према Наставном програму који се изучава на првој години 
струковних студија Високе техничке школе  струковних студудија у Звечану.  

Садржај је подељен у 15 делова које обухватају кратак приказ теме која се 
обрађује праћен практичним вежбама и питањима којима се проверава стечено 
знање након урађених вежби у Рачунарској лабораторији школе. За вежбу је 
потребно теоријски се припремити коришћењем референтне литературе за 
наведени предмет. 

Практикум је намењен стицању практичних знања за рад у Windows графичком 
окружењу (Windows XP), као и за рад у програмима Word 2003, Excel 2003, Outlook i 
Internet претраживач.  

Вежба бр. 1 представља упознавање са основама информационе технологије. 
Вежбе бр. 2 и 3. баве се основама рада у Windows окружењу укључујући 
организацију података на рачунару и рад са подацима и документима, а следећих 6 
(вежбе бр. 4, 5, 6, 7, 8 и 9) обрађује елементе рада у програму за обраду текста 
Word. Елементи рада у програму за табеларне прорачуне Excel обрађени су у 
вежбама бр. 10, 11, 12, и 13. Основе коришћења Интернета обрађене су кроз две 
вежбе: основни елементи програма Internet Explorer у вежби бр. 14 а програма 
Outlook у вежби бр. 15. 

Практикум за лабораторијске вежбе је намењен студентима прве године, смерови 
Енергетика и Менаџмент у Електротехници, Високе техничке школе струковних 
студија у Звечану као помоћ у стицању основних знања за рад на рачунару. 

Стога је неопходно напоменути да приликом похађања лабораторијских вежби, 
овај Практикум треба да буде ослонац при раду и да студент треба да самостално 
уради вежбу и попуни Практикум према захтевима вежбе. Такође, на сва 
постављена питања треба одговорити. Након урађених вежби, попуњену вежбу 
студент ставља на увид асистенту на предмету и асистент му је потписом оверава.  

Потпис асистента на Практикуму је услов за добијање потписа на крају 
семестра. Урађене лабораторијске вежбе носе 10 бодова у коначном збиру за 
оцењивање стеченог знања студента из предмета Основи рачунарске технике и 
програмирања.  

 

У Звечану       предметни наставник 

             Др Зоран Ј. Поповић 

 



 

 

ОООссснннооовввеее   ииинннфффооорррмммаааццциииоооннниииххх   тттееехххнннооолллооогггииијјјааа   
 
 
Кратак садржај обрађен у вежби: 
 
  Основни појмови 
 Хардвер и софтвер  

 Компоненте рачунара и њихове 
карактеристике 

 Питања 

   
   
   

   
ВВВееежжжбббааа   бббррр...   111   

ПППооојјјаааммм   иии   ссстттррруууккктттууурррааа   ииинннфффооорррмммаааццциииоооннниииххх   сссиииссстттееемммааа:::ХХХааарррдддвввеееррр   иии   СССооофффтттвввеееррр   
 
 

Информациони систем може се дефинисати као систем чији је задатак да уз 
минималне трошкове обезбеди потребне информације свим корисницима у сваком 
тренутку. Савремени информациони системи спадају у категорију на рачунарима 
базираних система (Computer-based systems-CBS). Њега чине следећи елементи: 

 
1. HARDWARE (ХАРДВЕР) – сви механички, електронски, магнетни и оптички делови у 

које спадају компоненте рачунара и терминала, мрежне компоненте и др.; 
2. SOFTWARE (СОФТВЕР) – системски и апликативни програми, као и програми за 

мрежни протокол; 
3. LIFEWARE (КАДРОВИ) – особље задужено за пројектовање и одржавање 

информационог система и корисници; 
4. ORGWARE (ОРГАНИЗАЦИЈА) – организациони поступци, методе и системи који 

омогућавају да претходне три компоненте функционишу као складна целина; 
5. NETWARE (РАЧУНАРСКЕ МРЕЖЕ) – пројектовање и реализација повезивања и 

комуникације између физички удаљених рачунара; 
6. DATA (ИНФОРМАЦИЈЕ) – подаци који се уносе, обрађују, користе, чувају и 

размењују. 
 

Рачунар је електронски уређај управљан инструкцијама похрањеним у 
оперативној меморији. Могућност програмирања рада представља основно 
својство електронских рачунара. Обрада података се обавља помоћу електронских 
компоненти које могу да прихвате и пренесу један од два електрична сигнала, 
означена бинарним цифрама 0 и 1. 

 
 

1. ХАРДВЕР 
  

Основни елементи хардвера персоналних рачунара (PC Personal Computer) 
приказани су на Слици 1.  
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Слика 1. Основне компоненте рачунара 
 
Разликујемо: 

1. Централна јединица 

1.1. Процесор (CPU – Централна 
процесорска јединица) 

1.1.1. ALU –аритметичко логичка јединица 
1.1.2. CU –контролно управљачка јединица 

1.2. Примарна ( радна,оперативна) меморија 
1.2.1. ROM (Read Only Memory)  
1.2.2. RAM (Random Access Memory)  

2. Секундарна (периферна) меморија  

2.1. Магнетне траке, диск и дискете 
2.2. CD компакт диск 
2.3. DVD 
2.4. FLASH DISK 

Улазне јединице 

2.5. Тастатура 
2.6. Миш 
2.7. Скенер 
2.8. Оптички читач и др. 

3. Излазне јединице 

3.1. Монитор 
3.2. Штампач 
3.3. Плотер (цртач) 

4. Улазно–излазне јединице 

4.1. Терминали 
4.2. Модеми 

 
 

2. СОФТВЕР 
 

Софтвер представља скуп свих програма који се налазе на рачунару. Основна 
подела софтвера је на:  

1) Системски – за контролу и управљање рачунаром 
 Оперативни системи 
 Услужни програми 

2) Апликативни (Кориснички) – за решавање конкретних корисникових захтева 
 
Веза између хардвера и софтвера симболично је представљена на Слици 2. 

Спољашње 
меморије 

ОМ 

 
CPU 

ALU CU 

Улаз Излаз 
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Слика 2. Веза хардвер – софтвер  
 

Споља гледано, ПЦ рачунари се састоје из три главне функционалне целине:  
(1) кућишта 
(2) монитора и 

(3) тастатуре 
и каже се да они чине његову основну конфигурацију. Наравно ту је и додатна 
периферијска опрема која је данас више него разноврсна, а што је приказано на 
Слици 3. 

 
 

Слика 3. Конфигурација ПЦ рачунара  
 

Ове целине могу бити различитог дизајна који није много напредовао у односу на 
технолошки развој који је пратио ПЦ од свог настанка па до данас.  

Два или више рачунара се могу повезати у мрежу, тако да један корисник може 
да приступа датотекама које су смештене на рачунару другог корисника. Мрежа се 
такође може користити за заједнички приступ штампачу или модему, или за слање 
електронске поште између корисника мреже. Мрежа је и добар начин да се 
побољшају комуникације и омогућава да се датотеке веома лако шаљу од једног 
корисника до другог.  

Јединице спољне меморије имају своја симболичка имена, састављена од 
великог латиничног слова и двотачке, тако је: A: и B:  резервисано за дискетне 
јединице; C:, D: ... за дискове и сл., а у Widows окружењу имају  и одговарајуће 
графичке симболе.  

На следећој страни приказан је различит распоред тастера на тастатури, као и 
места где се у ком случају налазе наша слова. 

Апликативни 
 
 
 
 
 
 
 

софтвер 

Системски 
 
 

 
софтвер  

хардве
р 
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YU распоред  

 
1. Ако је тастатура са YU распоредом слова, онда  ћете све знакове који су назначени на 

тастерима, писати са индикатором тастатуре подешеним на SR (Serbian Latin или  Cyrillic). 

 

EN (US) распоред  
 

 
2. Ако је тастатура са EN (US) распоредом слова, онда  ћете све знакове који су назначени на 

тастерима, писати са индикатором тастатуре подешеним на EN (English (US)). 

 
 

EN 
! 
1 

@ 
2 

# 
3 

$ 
4 

% 
5 

^ 
6 

& 
7 

* 
8 

( 
9 

) 
0 

_ 
- 

+ 
= 

SR  
(Lat, Cyr) 

! 
1 

“ 
2 

# 
3 

$ 
4 

% 
5 

& 
6 

/ 
7 

( 
8 

) 
9 

= 
0 

? 
‘ 

* 
+ 

 

EN Y 
{ 
[ 

} 
] 

: 
; 

“ 
‘ 

| 
\ 

< 
, 

> 
. 

? 
/ 

_ 
- 

SR  
(Lat, Cyr) 

Z Š Đ Č Ć Ž 
; 
, 

: 
. 

_ 
- 

> 
< 

 

EN, YU Q W X 

SR Cyrillic Љ Њ Џ 

Z 

Y 

Z 

Y 
 

ЋИРИЛИЦА 

РАЗЛИКЕ 
распореда 
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Одговори на питања: 

1) Бинарне цифре су ________и _________. 

2) Програм представља: 
a) скуп електронских компоненти 
b) прецизно формулисану групу инструкција које казују рачунару шта, како и којим 

редоследом треба да ради 
c) врсту меморије. 

3) Да ли су електронски рачунари програмабилни: 
a) не 
b) да 

4) Изабрани и међусобно повезани елементи физичке структуре чине ____________ 
рачунара. 

5) Системски софтвер сачињавају: 
a) меморија и процесор 
b) улазне и излазне јединице 
c) оперативни систем и услужни програми. 

6) Апликативни софтвер представља: 
a) скуп свих програма намењених обављању конкретних послова за које је 

корисник заинтересован 
b) део системског софтвера 
c) скуп програма за обављање основних функција рачунара. 

7) Централну јединицу рачунара (рачунар у ужем смислу) чине: 
a) процесор и радна меморија 
b) улазна и излазна јединица 
c) јединице спољне меморије. 

8) Две основне врсте радне меморије су ___________и__________ 

9) Радна фреквенција (такт) микропроцесора изражена је код савремених рачунара у 
________ 

10)  Миш је:  
a) улазни уређај 
b) излазни уређај 
c) улазно-излазни уређај. 

11)   Најбољи квалитет штампе има штампач: 
a) са млазницама 
b) ласерски 
c) матрични. 

12)  Спољне меморије са магнетним записом су: 
a) диск и дискета 
b) компакт диск и дискета 
c) компакт диск, диск и дискета. 
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13)  Капацитет чврстих дискова савремених рачунара изражава се у:  
a) КВ  
b) МВ  
c) GB. 

14)  Притиском на тастер Caps Lock укључује се режим исписивања: 
a) малих слова 
b) великих слова 
c) прекривања. 

15)  Програмабилни тастери су: 
a) F1-F12 
b) Space и Enter 
c) Delete, Backspace и Esc. 

16)  Која од наведених мерних јединица рачунарске меморије је највећа? 
a) gigabyte 
b) terabyte 
c) megabyte 
d) kilobyte 

17)  Програм за обраду текста и табеларне прорачуне спадају у 
a) Системске програме 
b) Апликативне програме 
c) Антивирус програме 
d) Програме за backup 

18)  Шта је CPU? 
a) Јединица за израчунавање (Calculating Process Unit) 
b) Контролна програмска јединица (Control Program Unit) 
c) Контролна процесна јединица (Control Process Unit) 
d) Централна процесорска јединица (Central Processing Unit) 

19)  Који од наведених уређаја представља улазну рачунарску јединицу? 
a) Звучник 
b) Скенер 
c) Штампач 
d) Монитор 

20)  Која је од следећих тврдњи о ROM-u истинита? 
a) ROM меморија омогућава читање и уписивање података 
b) ROM је рачунарска периферна меморија 
c) ROM меморија ће задржати податке по искључењу рачунара 
d) ROM меморија ће изгубити податке по искључењу рачунара 

21)  Шта од наведеног је истовремено и улазни и излазни уређај?  
a) Екран осетљив на додир (Touch screen)  
b) Тастатура  
c) Штампач 
d) Скенер  



 

 

ОООпппееерррааатттииивввннниии   сссиииссстттеееммм   рррааачччууунннааарррааа   –––   WWWiiinnndddooowwwsss   XXXPPP      
 
Кратак садржај обрађен кроз две вежбе: 
 
 Основни појмови 
 Основна подешавања у Windows-у 
 Приказивање садржаја рачунара 
 Рад са датотекама и фасциклама 

 Windows Explorer 
 Претраживање 
 Питања 
 Практичне вежбе 
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ОООссснннооовввннниии   пппооојјјмммооовввиии   иии   пппооодддееешшшааавввааањњњааа,,,   ррраааддд   сссааа   пппрррооозззооорррииимммааа   

 
Може се рећи да је Windows, као један од најзаступљенијих оперативних 

система, увео коришћење графичких објеката у комуникацији корисника са 
рачунаром. Његове главне карактеристике су: 

 Рад у графичком окружењу (GUI – Graphical User Interface), где се команде 
задају одређеним комбинацијама тастера или мишем уз коришћење симбола 
или икона; 

 Multitasking – истовремени рад са више програма; 
 Могућност размене података између различитих програма (OLE – Object 

Linking and Embedig) 
 Стандардизација радног окружења, где се програми (апликације) покрећу и 

завршавају на исти начин. Рад са програмом се одвија у прозору, а резултат 
рада се назива документом. Документи се, независно од програма, чувају на 
спољној меморији, проналазе и користе на исти начин; 

Због своје графичке оријентације рад у овом оперативном систему практично је 
незамислив без употребе миша. Померање миша на одређену страну по столу 
резултује истоветном померању на екрану њему придруженог симбола (најчешће је 
то стрелица). Понекад се уместо миша користи трек-бол (код преносних рачунара), 
који је у основи исти уређај, али се уместо покретања по столу, у одговарајућем 
смеру, дланом или прстом врти кугла. Разликујемо неколико операција: 

 Клик (или “леви клик”) представља краткотрајно притискање и отпуштање 
левог тастера миша. Обично се користи за означавање графичких објеката на 
екрану, њиховог избора или одређивања локације на којој ће се нешто урадити 
(рецимо, куцати текст).  

 Десни клик је исто такво притискање десног тастера миша. Ова акција 
обично служи за позивање помоћног менија.  

 Дупли клик представља два клика, поновљена брзо један за другим (при 
чему се не помера показивач миша), чиме се објекти активирају. Рецимо, 
дупли клик на икону неког програма ће активирати тај програм. 

 Одвлачење објеката се обавља тако што се над неким објектом притисне 
тастер  миша и, не отпуштајући га, објекат се одвуче на неко друго место.  
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Windows се аутоматски стартује када покренете рачунар. Представљање 
систему се назива логовање, којом приликом се уноси корисничко име  (username) 
и шифра (password).   

Типичан изглед основног Windows екрана приказан је на Слици 4. 
 

 

Слика 4. Делови основног Windows екрана  
 

Основни елементи су : 
 радна површина (Desktop) – преко које је кориснику омогућен приступ свим 

програмима и датотекама; 
 слике (графички објекти) на радној површини које се називају ikone (Icons); 
 линија послова (taskbar) која се налази на дну екрана:  

o на њеном левом крају налази се дугме на коме пише Start;  
o на десном крају (systray) налазе се различити индикатори и показивч 

системског времена; 
o сваком покренутом програму (отвореном прозору) придружено је једно 

дугме на  средишњем делу taskbar-а. У једном тренутку може бити активан 
само један програм, што је назначено утиснутим одговарајућим дугметом, 
као што је  приказано на Слици 5. 

 
   

   

Слика 5. Делови Taskbar-a 

Ikona 
foldera 

Ikona 
programa 

Radna površina 
(Desktop) 

Dugme 
Start 

Linija poslova 
(Taskbar) Indikatori 

Дугме неактивног прозора Дугме активног прозора 
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Дугме Start покреће стартни мени преко кога можемо активирати програме 
(подмени Programs), проверити слободан простор на диску, управљати датотекама, 
правилно искључити рачунар и друго. Покретање програма Notepad преко Start 
менија приказано је на Слици 6. 

 

Слика 6. Windows XP Start мени 

Означена команда препознаје се тако што је инвертована у плавој позадини. 
Команде се могу активирати и помоћу тастатуре кретањем стрелицама, као и  
притиском на Alt +podvučeno slovo. Мени Start се може отворити било притиском 
на Ctrl +Esc, било на за то намењен тастер на тастатури. Ако хоћете да затворите 
неки подмени, или сам Start мени, притисните Esc на тастатури.  

На дну Start менија налазе се две наредбе: Log Off (одјави) и  Turn Off computer 
(искључи рачунар, некад пише Shut Down). За правилно искњучивање рачунара 
треба изабрати Turn Off computer команду. Појавиће се дијалог као на Слици 7. 
Садржај овог дијалога зависи и од конфигурације вашег рачунара.  

 

  

Слика 7. Дијалог прозор команде Shut Down 
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 Тurn Off - Записује све податке на диск и припрема рачунар за потпуно 
искључење.  

 Restart - Обара систем и искључује рачунар, а одмах затим га укључује и 
покреће Windows  

 Stand By (Hibernate) - Искључује све уређаје осим меморије, тако да се 
систем врло брзо може вратити тачно на оно место где сте га пребацили у 
стање мировања. Ако нестане струје док је рачунар у овом режиму, подаци ће 
бити изгубљени.  

Рад са прозорима 

Ако дуплим кликом активирамо My Computer икону са радне површине (обично је 
у горњем левом углу), у прозору који се том приликом отворио можемо видети иконе 
уређаја који се налазе у рачунару, а што је приказано на Слици 8.  Видимо да 
рачунар има дискетну јединицу (А:), два хард диска (C:) и (D:), као и два оптичка 
уређеја DVD резач (E:) и CD читач (F:).  

 

 

 

Слика 8. Прозор My Computer (Мој рачунар) 

Основни елементи прозора су: 

 Насловнa линијa (title bar) налази се на врху и на њој се налазе: 

  контролно дугме у горњем левом углу; 

 дугмад за подешавање величине прозора у горњем десном углу и то: 

o за максимизацију прозора преко целог екрана (Maximize); 

o за минимизацију прозора (Minimize) чиме га сводимо на дугме у линији 
послова. Тако се уклања са екрана, али је и даље активан; 

Линија наслова 
Подешавање 
величине прозора Линија менија Линија алата 

Scroll bar 
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o дугме Restore видљиво је само када је прозор максималне величине и 
користи се да врати (рестаурира) величину прозора на ону која је 
претходила максималној; 

o дугме за затварање прозора (Close)   

 Линија менија (Menu bar) садржи наредбе или опције. Стрелица десно од опције 
(►) указује на постојање подменија, а кликом на стрелице са усмерењем надоле 
отвара се цео мени; 

 Линија алата (Tool bar) са иконама којим се могу реализовати одређене акције; 

 Поља за померање садржаја (Scroll bars), могу бити хоризонтални и 
вертикални; 

 Радни простор. 

Повлачењем насловне линије прозор се може премештати, а повлачењем ивица 
и углова прозора може му се мењати величина. Када се курсор миша постави на 
неку ивицу или угао облик курсора ће се променити у двострану стрелицу што је 
приказано на десној ивици прозора приказаног на Слици 8. Сам појам повлачење 
подразумева кретање миша са притиснутим тастером. 

 

Основна подешавња 

Основна подешавања у Windows-у врше се преко Control Panel-а (из менија Start  
или преко My Computer) а што је приказано на Слици 9. Ту се подешава изглед 
прозора, додају и уклањају програми, подешавају регионалне карактеристике (језик, 
датум, време) и др.  

Неке наредбе се могу наћи и на помоћном (контекстном, приручном) менију 
који се отвара притиском на десни тастер миша. Садржај тог прозора зависи од 
објекта на који је у том тренутку показивао курсор миша.  

 

 

Слика 9. Прозор Control Panel 
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Једноставан пример је подешавање датума и времена избором Date and Time 
Properties чиме се добија прозор као на Слици 10. 

 

 

Слика 10. Прозор за дијалог Date and Time Properties 

Ако се изабере опција Display могу се подешавати разне ствари: од избора 
позадине Desktop-a, избора различитих шема боја које ће Windows користити за 
своје објекте, до подешавања ScreenSaver-a (чувара екрана), а што је приказано на 
Слици 11. 

   

Слика 11. Подешавање изгледа екрана и избор Screen Saver-a 

Алтернативно се до овог прозора може доћи избором опције Properties из 
помоћног менија везаног за радну површину.   
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Ако се изабере картица Screen Saver, може се подесити да се после после 
одређеног периода неактивности (који задајете сами–поље Wait), искључи слика. Да 
би се она вратила и ви наставили тамо где сте стали, довољно је да кликнете на 
било који тастер тастатуре или да померите миша. Постоји једна битна чињеница 
која иде у прилог заштити екрана, а то је да у Windows-у постоји могућност њихове 
заштите шифром. Ово је посебно важна могућност у фирмама, где има много људи.  

 

Подршка за ћирилична и латинична слова 

За сам рачунар оно што пише на тастерима нема никаквог значаја – ако 
притиснете слово А, оперативни систем ће примити само број тог тастера, 
"погледати" у одговарајућу табелу и видети да је у питању то слово. Дакле, сама 
измена те табеле мења распоред слова, без обзира шта на њима физички пише, тј. 
рачунар их све третира на исти начин. Како онда "рећи" рачунару коју тастатуру 
желимо? За то је задужена опција  Regional and Language Options из Control 
panel-а, чијим се избором добија прозор као на Слици 12. 

 

  

Слика 12. Прозор за дијалог Regional and Language Options  

На Language листи нови тастатурни распоред додајемо избором Details, 
притиском на дугме Add и изабором опције Serbian (српскa ћириличну или 
латиничнa). Српска тастатура има QWERTZ распоред за разлику од Америчке 
(Енглеске) где је распоред QWERTY, а њто је и приказано у Вежби 1. Пошто су 
најчешће потребни и српски и амерички рапосред (јер нпр. на српском нема знака @, 
као ни угластих и великих заграда), нема никаквих проблема да се инсталирају оба. 
У сваком случају укључите опцију Enable indikator on taskbar. У доњем десном углу 
ће се појавити плави квадрат са уписаном скраћеницом, SR за српски и EN за 
енглски као што је приказано на Слици 13, тако да увек знате који је језик активан. 



Основи информатике - Практикум 

 

22

Поред комбинације тастера, клик на овај индикатор отвара листу, у којој опет кликом 
можете изабрати било коју инсталирану тастатуру.  

 

 

Слика 13. Индикатори на Taskbar-у за избор тастатурног распореда и писма 
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Уради Вежбу: 

1. Покренути апликацију: Notepad и Calculator. 

2. Променом величине и премештањем прозора постићи да оба прозора буду 
видљива. 

3. Мењајте активни прозор: 

 Активирањем тастера на палети послова 

 Командом <Alt + Tab>. 

4. Минимизирати све прозоре. 

5. Затворити минимизиране апликације. 

6. Отворите прозор My computer. 

7. Погледај које су приказане иконе уређаја на рачунару у прозору My computer. 

8. Запази које су меморијске јединице присутне. 

9. Колики је капацитет диска C: ? __________________________ 

10. Промените позадину радне површине. 

11. Подесити активирање Screen Saver-a након 15 минута. 
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ВВВееежжжбббааа   бббррр...   333   
РРРаааддд   сссааа   дддааатттооотттееекккааамммааа   иии   фффааасссццциииккклллааамммааа,,,   пппрррееетттрррааагггааа   сссааадддррржжжааајјјааа,,,                                 

WWWiiinnndddooowwwsss   EEExxxppplllooorrreeerrr   
 

 Скупове истоврсних података са неким заједничким обележјима организованих у 
логичке целине на јединици спољне меморије називамо датотекама (или "фајлови", 
од енглеског File). Свака датотека има име састављено из два дела, раздвојена 
тачком. Први део имена дајемо сами, а други део се најчешће састоји од три знака, и 
назива се екстензија. Екстензија показује о којој врсти документа (фајла) је реч, тј у 
ком је програму настала. Windows омогућује дужину имена од 256 знакова, али се у 
имену датотеке не смеју наћи знакови ( \ / : * '' > < |) јер имају посебно значење за 
оперативни систем.  

Датотеке увек садрже само нуле и јединице које се интерпретирају на различите 
начине. Word ће у DOC датотекама смештати текстове, Excel у XLS датотекама 
табеле, Photoshop слике у JPG, TIFF, BMP и другим датотекама (један програм има 
могућност препознавања и више врста датотека). Да би се садржај правилно 
интерпретирао, неопходно је да знамо у ком програму је датотека настала, а то 
знамо управо помоћу трословне екстензије имена. Постоје и тзв. "извршне" датотеке, 
које садрже програме. Када дупло кликнете на њих, покреће се сам програм. 
Најчешћа екстензије ових датотека су EXE, COM i DLL.  

Датотеке организујемо преко фасцикла (Folder, каталог, директоријум), у које 
смештамо датотеке груписане према садржају или намени или друге фасцикле. На 
овај начин једноставно се креира каталошка структура (стабло) као план размештаја 
датотека на спољњој меморији. Име датотеке мора бити јединствено за ту фасциклу.  

Током рада на рачунару често се јавља потреба за копирањем, премештањем и 
брисањем датитека и/или фасцикли као и променом каталошке структуре. За то се 
углавном користи програм Windows Explorer, који омогућава организацију и преглед 
података са каталошком структуром. Покреће се преко Start менија. Налази се у 
трећем нивоу, у групи Accessories. Explorer се може покренути и кликом десним 
тастером миша на дугме Start менија или на икону My Computer, и затим на ставку 
Explore, као и истовременим притиском на тастере Windows (уколико их има на 
тастатури) и Е. 

Лева страна Explorer прозора садржи хијерархијску структуру вашег рачунара, 
док десна приказује садржај ресурса који је изабран на левој. Притиском на 
квадратић са уписаним знаком + (или -) биће приказана (или затворена) 
подструктура дотичног ресурса, био то диск C, нека фасцикла или нешто сасвим 
друго.  

Кликом на дугме Views  појавиће се листа са које можете изабрати неку другу 
врсту приказа (Thumbnails, Tiles, Icons, List i Details), као што је приказано на 
Слици 14.  
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Слика 14. Прозор Windows Explorer и опције команде View   

 

Руковање фасциклама и датотекама 

 Креирање фасцикле – Нова фасцикла (Folder) креира се из менија               
File  New  Folder  

 Означавање (селектовање) – се обавља једноставним кликом на објекат. 
Селектовање више датотека или фолдера који се налазе у низу ради се 
мишем тако што се означи први објекат, а затим држећи притиснут тастер 
Shift, кликне се на последњи у низу. За означавање више датотека које нису у 
низу, означава се свака од њих појединачно држећи при том притиснут тастер 
Ctrl. За означавање целокупног сарджаја фасцикле користи се наредба Sellect 
All из менија Edit.  

 Отварање (покретање) – Дупли клик на жељену датотеку, где ће Windows 
препознати одговарајући програм у који служи за отварање датотека са том 
екстензијом, покренути га, и учитати је. Алтернатива је означавање датотеке и 
притисак на тастер Enter.  

 Копирање и премештање – Објекат (датотека или фасцикла) једноставно 
ухватите десним тастером миша и одвците на жељену локацију. Када пустите 
десни тастер миша, појавиће се дијалог прозор, у којем бирате опцију Copy here 
ако објекат желите да копирате, односно, опцију Move here ако желите да га 
преместите. Жељена локација може бити нека фасцикла, флопи, други хард диск 
и сл. Постоји и друга опција која почива на коришћењу Clipboard-a (огласна 
табла). То је сегмент радне меморије (buffer), у који сваки програм може да 
пошаље податке или да их из њега учита, ако их тамо има. То је начин за размену 
података између разних програма. За то се користе наредбе Cut (исеци или 
Ctrl+X), Copy (копирај или Ctrl+C) и Paste (прилепи или Ctrl+V) из менија Edit. 

 Брисање - Потребно је селектовати жељене објекте, а затим притисне дугме 
Delete (обриши) на тастатури или изабере наредба Delete  у менију File (File 
 Delete), или из помоћног менија. У дијалог прозору вам се нуде две опције - 
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да ли заиста желите да извршите ову операцију и пошаљете све у канту за 
ђубре Recycle Bin, (кликните на Yes) или не (кликните на No). Објекат који је 
грешком избрисан можете вратити помоћу наредбе Restore this item (врати 
ову ставку) из прозора који се отвара двоструким кликом на Recycle Bin 
(корпа за отпатке). 

 Промена имена - Означите датотеку или фасциклу. Из менија File бирамо 
наредбу Rename (File  Rename). 

 Пречице – Икону за било који програм или фасциклу можемо поставити на 
радну површину (Desktop) тако да она указује на оригинални објекат. Такве 
датотеке се називају пречице (Shortcuts), а лако се препознају по малој 
стрелици у доњем левом углу. Када дупло кликнете на њу, активира се објекат 
на који она показује – то може бити документ, програм или фасцикла. Њихово 
креирање је једноставно. Кликните десним дугметом на било које постојеће 
име или икону, а затим на опцију Create Shortcut. У фасцикли у којој се 
налазите појавиће се још једна икона, управо креирана пречица названа 
"Shortcut to...". Ову икону одвуците на жељено место, и операција је 
завршена. 

Претраживање  

Кликните на Start дугме, затим поставите показивач миша на поље Search 
(тражи), и појавиће се подмени који је приказан на Слици 15. 

Имамо посебно третиране знаке у претраживању ресурса и то два – "*" и "?". 
Звездица замењује било који низ знакова (чак и празан). Знак питања функционише 
на сличан начин, али замењује само један знак – а не било какав низ.  

До опције претраживања у Explorer-у долазимо притиском на десни тастер миша 
приликом селекције одређеног ресурса чиме се отвара помоћни (контекстуални) 
мени са опцијом Search.   
 

  

Слика 15. Search мени и изабрана опција All files and folders 



Оперативни систем рачунара – Windows XP 

 

27

Уради Вежбу: 

1. Отворите прозор My computer. 

2. Испитати утицaј постојећих опција из менија View (Thumbnails, Tiles, Icons, List, 
Details). 

3. Покренути Windows Explorer. 

4. Уочити фолдере који имају испред знак + , а затим прикажи њихов садржај. 

5. У фасцикли D:\Student\ORT  креирајте подфасциклу са вашим именом и 

презименом . (нпр.   D:\Student\ORT \Petar_Petrovic )  

6. У креираној подфасцикли Petar_Petrovic креирајте подфасциклу Test. 

7. Прикажи садржај неке преносне меморије Е: 

8. Копирајте једну датотеку из фолдера My documents у подфасциклу Test. 

9. Копираној датотеци промените име у MojDokument. 

10. Обришите датотеку, а затим и фасциклу Test. 

11. На диску D  направити нови фолдер и назвати га Test 1. 

12. У фолдеру Test 1 креирати два нова фолдера и назвати их PrviDan и DrugiDan. 

13. У фолдеру Test 1 креирати пречицу (Shortcut) фолдера PrviDan. 

14. Копирати пречицу (Shortcut) фолдера PrviDan на диск  D  и променити јој име у 

PrecicaPrviDan. 

15. Направите пречицу (Shortcut) за програм Calculator који се налази у подменију 

Accesories Start менија. 
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Одговори на питања: 

1) Оперативни систем је: 
a) физичка структура рачунара 
b) апликативни софтер 
c) програм који управља хардвером и омогућава комуникацију корисник - рачунар. 

2) Оперативни системи Windows cy графички оријентисани: 
a) да 
b) не 

3) Прибор за рад на радној површини представљен је минијатурним графичким 
објектима који се зову _________________ 

4) Палета послова састављена је из: 
a) два дела (дугме Start и статусно поље) 
b) два дела (дугме Start и поље активних програма) 
c) три дела (дугме Start, статусно поље и поље активних програма). 

5) Прозор програма не може да мења положај и величину: 
a) не 
b) да. 

6) Датотека представља део ________ меморије рачунара у коме је смештен скуп  
међусобно повезаних података. 

7) Повежите иконе са називима: 

 
a)    a) икона програма 
 
 
 
b)    b) икона фасцикле 
 
 
 
c)    c) икона датотеке 

 

8) Који програм користимо за рад са датотекама и фасиклама? 

9) Control Panel је програм за: 
a) прегледање каталога и датотека 
b) обраду нумеричких података 
c) подешавање компоненти рачунара. 

10) За брисање знакова служе тастери: 
a) Esc и Enter 
b) Shift и Alt 
c) Delete и Backspace 
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11)  Коришћењем десног тастера миша отвара се ___________________мени. 

12)  За време коришћења програма Notepad дугме овог програма на палети послова: 
a) је утиснуто 
b) није утиснуто 

13)  Техника „повлачења" миша подразумева: 
a) кретање миша 
b) кретање средњег тастера миша 
c) кретање миша са притиснутим тастером 

14)  Прозор програма не може да мења положај и величину: 
a) не 
b) да. 

15)  Алатке су смештене на палети: 
a) Title Bar 
b) Taskbar 
c) Toolbar 

16)  Уређивање приказа садржаја каталога врши се: 
a) опцијама из менија Edit 
b) опцијама из менија File 
c) опцијама из менија View 

17)  Командом Properties приручног менија дискете прегледаћете: 
a) датотеке на дискети 
b) каталоге на дискети 
c) карактеристике дискете 

18)  Након означавања каталога у ком желите да формирате нови каталог 
активираћете команду: 
a) File ►New ►Folder   
b) File ►Format   
c) File►Rename 

19)  Clipboard (прихватна меморија) омогућава: 
a) размену различитих типова података између различитих програма 
b) размену различитих типова података само у оквиру истог програма 
c) отварање докумената различитих програма. 

20)  У истом каталогу може бити више датотека са истим именом: 
a) да 
b) не. 

21)  Слово G у акрониму GUI потиче од:. 
a) Generic 
b) Global 
c) Graphical 
d) General 
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22)  Шта је оперативни систем? 

a) Софтвер који контролише рад свих компоненти у рачунару 
b) Софтвер задужен за анти-вирус операције 

c) Софтвер за операције са базама података 

23)  Који од понуђених одговора описује шта се дешава са датотекама када се обришу 

из корпе за отпатке? 
a) Датотеке се премештају на дискету 

b) Датотеке су трајно обрисане 
c) Датотекама се мења име 

d) Датотеке се премештају у привремену (temporary) фасциклу 
 
 



 

 

ПППрррооогггррраааммм   зззааа   оообббрррааадддууу   тттееекккссстттааа   –––   WWWooorrrddd      
 

Садржај је обрађен кроз шест вежби које обухватају: 
 
 Основнe појмовe и покретање 

програма 
 Начин приказивања документа 
 Форматизацију фонтова и 

параграфа 
 Листе набрајања 

 Рад са табелом 
 Форматизација стране, припрема 

за  штампу 
 Практичне вежбе 
 Питања 

 

   
ВВВееежжжбббааа   бббррр...   444   

WWWooorrrddd,,,   оооссснннооовввннниии   пппооојјјмммооовввиии,,,   ррраааддд   сссааа   дддооокккууумммееенннтттоооммм   
 

Мада су рачунари ушли у практично све домене живота, обрада текста је још увек 
најзаступљенији вид њихове примене. Које су главне предности обраде текста на 
рачунару? У првом реду, то је могућност једноставне исправке текста, затим долази 
напредно форматирање – маргине, различите врсте и величине слова, примена боја, 
графика, једначине, табеле..., могућности су велике. Рачунари такође омогућују 
једноставно копирање делова или целих текстова,  а уколико нам је потребно више 
копија документа једноставно га одштампамо у више примерака. Ту је још мноштво 
аутоматизованих операција као што су бројеви страна, креирање садржаја и много 
других којима се значајно олакшава и унапређује обрада текста.  

 

Под обрадом текста подразумева се: 
 Унос текста, 
 Модификација (измена) 
 Чување (на спољној меморији) 
 Штампање  

 
Стартовање програма Word је на стандардни начин: 

 Каскадни мени  Start  Programs  Microsoft Word 
 Активирање иконе на радној површини (ако постоји) 

 

Задавање команди може се извести на један од већ описаних начина: 
 Избор команде из менија 
 Комбинација тастера 
 Активирање алатке из Toolbar линије 

 

Основни делови прозора програма приказани су на Слици 16. На врху је, 
наравно, насловна линија, испод које се налази линија менија. Непосредно испод ње 
су линије са алаткама (Toolbar). Ту су и хоризонтални и вертикални лењир (Ruler), 
чија је намена да олакша сналажење са маргинама и другим елементима 
позиционирања у раду. Највећи део екрана, наравно, заузима радна површина, која 
представља замишљени лист папира, на коме се појављује текст. На десној страни 
је вертикална трака за померање садржаја (Scroll bar). На њеном дну налазе се 
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дугмад за брже кретање. Њен хоризонтални еквивалент је испод радног дела 
прозора, а на левој страни су дугмад за избор врсте приказа чији детаљнији опис 
ћете наћи у следећој вежби. Испод хоризонталне траке се налази статусна линија, у 
којој се све време исписују информације о величини текста и вашој позицији у њему, 
као и активни језик и статус контролних тастера.  

 

 

Слика 16. Основни елементи прозора програма Word   

Основне команде везане за документ програма Word налазе се у File менију који 
је приказан на Слици 17. 
 

 

Слика 17. Команде из File менија програма Word   

Насловна линија 
програма и документа 

Мени линија 

Палете са алаткама – Toolbar 

Радни простор 
документа 

Статусна линија 

Лењири 

Траке за померање садржаја 
– Scrollbar 

Тастери за избор 
приказа документа 

Тастери за кретање 
по документу 

Отвори нови документ 

Отвори постојећи документ 

Затвори документ  

Сачувај документ 

Сачувај документ под новим именом 
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Када се први пут активира Word, на екрану се појављује празан документ, спреман за 
унос (куцање) текста. Он се зове Document1, следећи нови је Document2 итд. Нови 
документ креирате избором команде New из менија File или кликом на икону New Blank 
Document на линији са алаткама или преко тастатуре, комбинацијом тастера Ctrl+N. 
Обратите пажњу да се нови документ појављује као засебан прозор (у 
претходнимверзијама Word-а то није случај), чије дугме видимо на Taskbar – у. 
 

Формирање новог документа: 

 Из менија File  New  

  

 комбинацијом тастера Ctrl+N 
 
Том приликом добијамо прозор за дијалог New као што је приказан на Слици 18: 

    

Слика 18. Дијалог прозора команде New (нова и стара верзија Word-а) 

Да бисте отворили постојећи документ, изаберите команду Open из менија File 
или кликом на икону Open на линији са алаткама, или комбинацијом тастера Ctrl+O. 
У сваком случају се добија исти дијалог прозор приказан на Слици 19: 
  
Отварање постојећег документа: 

 Команда File  Open  

  

 комбинација тастера Ctrl+O 
 

На левој страни дијалога је листа фасцикли у којима се налази вертикала са неколико 
најпосећенијих места на вашем диску – то су: My Recent Documents листа, у којој се 
налази списак докумената са којима је нејскорије рађено; Desktop, вам директно отвара 
локацију радне површине да на њој пронађете жељену датотеку; што исто важи и за 
остале локације My Documents, My Computer и на крају My Network Places, преко кога 
можете да приступите документима на локалној мрежи или на Интернету. У пољу Files of 
type дефинише се тип документи који ће бити приказани у дијалогу Open. Оно 
функционише као маска која дозвољава да се прикажу само документи одређене ексте-
нзије. По избору локације и жељеног документа из десног дела прозора кликните на 
дугме Open. 
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Ако се тражени документ не налази ни у једној од понуђених фасцикли, до њега 
ћете доћи на стандардан начин, преко поља Look In. 
 

 

Слика 19. Дијалог Прозор команде Open 

Када се документ чува први пут, потребно је дати му име и сместити га на 
жељено место на диску. Да бисте то урадили, одаберите команду Save As из менија 
File. На екрану се појављује дијалог прозор приказан на Слици 20.  

У пољу Save in  пронађите фасциклу (место) где ћете сачувати документ, а у поље 
File name унесите име под којим желите да га снимите. У пољу Save as type бирате у 
ком формату ће документ бити сачуван. Формат чувања је, у већини случајева, Word 
Document (*.doc). То је класичан формат верзије Word–a, коју тренутно користите. Ако 
желите да ваш документ буде сачуван у некој старијој верзији у том пољу ћете изабрати 
жељену ставку. Након тога кликните на дугме Save. 
 

 

Слика 2.0 Дијалог Прозор команде Save As 

Листа за избор каталога 
Активни каталог 

Поље за име 
документа 

Командно дугме 
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Ако је документ већ једном сачуван (именован), све наредне измене у њему се 
чувају командом Save из менија File или комбинацијом тастера Ctrl+S. Постојећи 
документ можете сачувати под новим именом, командом Save As.  

 
Чување документа: 

 Команда File  Save  (чува под постојећим именом)  

 Команда File  Save  As (увек отвара прозор за име) 

  

 комбинација тастера Ctrl+S 

Рад на документу завршавамо активирањем команде Close из менија File или 
једноставно кликом на дугме за затварање прозора. Ако пре тога нисмо сачували 
унете промене појавиће се дијалог у коме ће се тражити потврда да се промене 
сачувају као што је приказано на Слици 21. 

 

Слика 21. Дијалог при затварању документа 

Избором опције Yes, Word ће ће једноставно сачувати последњу верзију 
документа (ону коју у том тренутку видите на екрану) на истом месту, под истим 
именом, а уколико документ пре тога није уопште био сачуван појавиће се већ 
објашњени дијалог прозор команде Save As. Избором опције No, документ ће се 
затворити без чувања измена у њему, односно, остаће верзија документа коју сте 
посљедњу сачували. Увек пажљиво прочитајте које име документа се појављује у 
горњем дијалог прозору. Обично је на екрану отворено више докумената, а најчешћа 
грешка је да се, без размишљања, кликне на тастер No и тиме не сачувају измене у 
њему.  
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Уради Вежбу: 
 
1. Отворити празан документ у Word-u. 

2. Одабрати латинично писмо по избору. 

3. Уписати ваше име и презиме. 

4. Сачувати документ под именом prva.doc у фасцикли ваше групе коју сте 

формирали у претходној вежби. 

5. Дописати затим на крај текста датум и место вашег рођења. 

6. Сачувати измењени документ под истим именом. 

7. Затворити документ prva.doc 

8. Поново отворити документ prva.doc 

9. Дописати на крају унетог текста ваш број индекса. 

10. Сачувати документ под именом Ime_Prezime.doc (ваше име и презиме) 

11. Затвори све отворене документе и заврши рад са Word-om. 
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ВВВееежжжбббааа   бббррр...   555   
НННааачччиииннн   пппрррииикккааазззииивввааањњњааа   дддооокккууумммееенннтттааа,,,   уууннноооссс,,,   ооозззнннааачччааавввааањњњеее                                                                     

иии   бббрррииисссааањњњеее   тттееекккссстттааа   
 

Врста приказа (изглед) документа на екрану се подешава избором View из мени 
линије и притиском одговарајуће команде (Normal, Web, Print Layout (у претходним 
верзијама Word-a звао се Page Layout), Outline или преко тастера у доњем левом 
углу екрана (погледати претходну вежбу), а што је приказано на Слици 22. Разлике 
се своде на начин приказивања и немају никаквог утицаја на сам садржај документа. 
Најбитнији су Normal, који је погодан за спорије рачунаре,  јер текст приказује без 
исцртаних страна, заглавља, подножја и сличног и Print Layout, који текст и целе 
стране приказује баш онако како ће се појавити на папиру.  

 

 

Слика 22. Команде из менија View 

 
Линије са алаткама (Toolbars) могу се активирати и деактивирати простим кликом 

на листу коју добијемо избором команде Toolbars  из менија View као што је 
приказано на Слици 23. Стандардно су постављене алатке Standard и Formatting.  

Листа Zoom oмогућава да се дефинише однос величине приказа садржаја на 
екрану и његове реалне величине на папиру у процентима, што се може подесити и 
иконом са Standard линије алатки. Постоје још и три врло практичне опције за 
аутоматско подешавање, а то су: 

 Page width, која ће страну приказати тако да се њена ширина поклапа са 
ширином екрана, 

 помоћу опције Text width постиже се исто, али само за текст без маргина 
 Whole page приказује целу страну одједном па је погодна за преглед њене 

естетске композиције 
 Many pages омогућује приказ више целих страна одједном, а њихов број бира 

се кликом на дугме поред.  
 

Различити начини 
приказа документа на 
екрану 

Одређују се палете са 
алаткама које се постављају 
и уклањају 

Одређује се величина 
приказаног дела документа 
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Слика 23. Део листе за укључивање и искључивање палети са алаткама 

Најмања недељива јединица текста је знак који може бити слово, број, знак 
интерпункције и специјални знак. Визуелна карактеризација знака одређена је 
фонтом који се користи приликом писања. 

Основни елементи текста су слова, речи и реченице, који када се групишу у 
целине називамо параграфом (пасус) који се раздвајају притиском на тастер <Enter> 

На распоред и изглед текста у документу утичу: 

 параметри дефинисани за страну 
 параметри везани за фонт 
 параметри везани за параграф 

 
Све се може подесити у било ком тренутку (пре започињања куцања, па до краја 

куцања), што означава да је главни посао ипак унос самог текста. 

Када желите да обавите неку операцију над било којим делом текста, нпр. да 
промените врсту или величину слова потребно је прво да их означите. Означавање 
је поступак који ће Word-u »рећи« над којим делом текста желите да примените 
следеће операције. Означавање (селектовање) произвољног дела текста може се 
постићи: 

 повлачењем мишем 
 помоћу курсора тастатуре и тастера <Shift> 
 за правоугаону површину иде комбинација:  <Alt>+ мишем се означи горњи 

леви и повлачи до доњег десног угла 

Селектовани део текста означен је инверзно као што је приказано на Слици 24. 

Брисање текста: 

 <Backspace> - брише једнак знак лево од курсора тастатуре 
 <Delete> - брише један знак десно од курсора тастатуре 
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Слика 24. Изглед селектованог дела текста 

Уколико желимо да селектовани део текста копирамо или померимо на неку другу 
локацију у документу користићемо Clipboard – прихватну меморију за размену 
података и то на следећи начин: 

  копирање – комбинација Copy + Paste на означеном делу текста 
  селектује се жељени текст 
 активира наредба Copy (из менија Edit, комбинација тастера, из Toolbar-а) 
 постави се курсор на жељено место 
 активира се наредба Paste (из менија Edit, комбинација тастера,из Toolbar-а) 

 
 премештање – комбинација Cut + Paste на означеном делу текста 

 селектује се жељени текст 
 активира наредба Cut (из менија Edit, комбинација тастера,из Toolbar-а) 
 постави се курсор на жељено место 
 активира се наредба Paste (из менија Edit, комбинација тастера, из Toolbar-а) 
 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Cut Copy Paste 
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Уради Вежбу: 

 

1. Отворите документ сачуван у претходној вежби под вашим именом и 
презименом. 

2. Измени садржај тако да ваше име и презиме буде у другом реду, датум и 
место рођења у четвртом, а број индекса у шестом реду. 

3. Упиши у трећи, пети и седми ред исти текст као у другом, четвртом и 
шестом реду респективно али ћириличним писмом. 

4. Пређи у десети ред и ту ископирај доле уписани текст (Ulazne jedinice...) 

5. Сачувајте измене у документу. 

6. Селектуј текст написан ћирилицом и пребаци га на крај документа. 

7. Сачувај измене у документу под именом promena.doc у фасцикли ваше 

групе. 

8. Заврши рад са Word-om.  

 

Ulazne jedinice 

 

Osnovni zadatak svih ulaznih jedinica je u tome da podatke i informacije (u 

alfanumeričkom, zvučnom i video obliku) prenesu na nosač podataka, u centralnu 

jedinicu računarskog sistema. 

Karakteristika svih ulaznih jedinica jeste da rade pod kontrolom upravljačke 

jedinice (kanala i kontrolera) u svim slučajevima kada su u tzv. on line vezi sa 

centralnom jedinicom. 

U ovu grupu jedinica (uređaja) ubrajaju se: 

 tastatura, 

 miš, 

 skener, 

 mikrofon, 

 čitač bušenih kartica i dr. 
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ВВВееежжжбббааа   бббррр...666   
ФФФооорррмммааатттииизззааацццииијјјааа   тттееекккссстттааа,,,      пппооодддееешшшааавввааањњњеее   фффооонннтттооовввааа                                                                                       

иии   пппааарррааагггрррааафффааа   
 

 
Као што је већ речено у претходној вежби на распоред и изглед текста у 

документу утичу: 
1. параметри дефинисани за страну 
2. параметри везани за фонт 
3. параметри везани за параграф 

 
Форматирање параметара везаних за фонт и параграф ради се командама из 

менија Format као што је приказано на Слици 25. 
 

 

Слика 25. Листа команди из менија Format и прозор команде Format ►Font 

  

Знак може бити слово, број, знак интерпункције и специјални знак. Визуелна 
карактеризација знака одређена је фонтом који се користи приликом писања. Избор и 
подешавање фонтова преко менија Format ►Font  приказано је такође на Слици 25. У 
оквиру једног фонта постоји више стилова и величина.  

 Стилови: 

 обичан (regular) 
 подебљан (bold) 
 искошен (italic) 
 подвучен (underlined) 

 
Size листа служи за промену величине фонта, која се изражава у типографским 

тачкама (points, ili skraćeno »pt«) величине 1/72 inča. Стандардна величина фонта је 
12pt. Са Font color мењамо боју слова, што постаје све потребније масовном 
употребом колор инк-јет штампача.  Ефекти (Effects), међу којима су прецртавање 
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(Strikethrough), експоненти (Superscript), индексi (Subscript), сенчење (Shadow) и 
други, се много ређе користе од осталих начина форматирања. Све промене које 
направите ће бити приказане у Preview прозору.  

 

Можемо користити и алатке са Toolbar-a као што је приказано на Слици 26. 
 

 
          

          

Слика 26. Команде из Toolbar-a за форматизацију фонта 

 
Wорд параграфом (тј. одељком или пасусом) сматра текст од почетка до краја 

»новог реда«, тј. следећег притиска на тастер Enter. За разлику од форматирања 
фонтова, можете, а не морате означити параграф пре његовог форматирања–
довољно је да у њега поставите курзор. Избором команде Paragraph  из менија 
Format (Format ►Paragraph) добија се дијалог прозор приказана на Слици 27. 
 

  

 

Слика 27. Дијалог прозор команде Format ►Paragraf 

Врста фонта Величина фонта Стил 

 
Боја фонта 
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 Alignment – поравнање (положај леве и десне ивице текста у односу на страну и 
може бити  

o Лево (Left) 
o Центрирано (Centered) 
o Десно (Right) 
o Обострано (Justified) 

 Indentitation– Ивице параграфа могу бити постављене независно од маргина 
остатка текста што се постиже уносом у поље Left односно Right. Ако је вредност 
нула, нема промене. Позитивне вредности померају ивице параграфа ка унутра у 
односу на маргине текста, док негативне раде обрнуто – дотични параграф, ако је 
потребно, може бити шири од остатка текста.  

 Special–листа омогућује постављање првог реда независно од остатка 
параграфа, и то његовим увлачењем (First line) или извлачењем (Hanging). 
Поље By одређује колико ће то померање износити.  

 Spacing– Може се дефинисати и простор испред (Before), иза (After) и између 
редова самог параграфа (Line spacing).  

 Поље Preview све време приказује шта ћете на крају добити. 
 

Велика помоћ при форматирању је лењир, који се укључује и искључује преко 
менија View►Ruler.   

<Tab> - тастер табулатора чијим притиском се курсор тастатуре помера за 
предефинисани број (1,27 цм). Обично се користи за увлачење првог реда 
параграфа. 
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Уради Вежбу: 

 
1.  Отворите документ promena.doc сачуван у претходној вежби у фасцикли ваше 

групе 

2.  Уклоните све палете са алаткама. Поставите палете Standard i Formatting. 

3.  Уклоните и поставите лењир - Ruler. 

4.  Подесите величину приказаног документа на ширину стране (Page Width) 
помоћу алатке Zoom. Мењајте величину приказа документа. 

5.  Изаберите изглед документа Normal. Прегледајте документ у изгледу Normal. 
Поново подесите странични изглед (Print Layout) и уочите разлике између ова 
два начина приказивања документа. 

6.  Форматизуј садржај на следећи начин: 

7.  Величина слова нека буде 12, врста писма Tahoma. 

8.  Поравнање текста: уз десну и леву маргину (Justify). 

9.  Први ред првог пасуса је увучен. 

10. Проред за прва два пасуса је двоструки са размаком од 6 pt. 

11. Проред за текст у набрајању је једноструки. 

12. Сачувај промене у документу. 

13. Пређи на следећу страну и ископирај доле уписан текст (Izlazne jedinice...) 

14. Сачувај документ под именом formatiran.doc у фасцикли ваше групе и заврши 
рад са Word-om 

 

 

Izlazne jedinice 

U izlazne jedinice spadaju:  štampač, jedinice za govorni  izlaz, ploter, terminali, 

magnetna traka, magnetni disk, kompak disk itd. 

Osnovne vrste štampača koje su u široj upotrebi su: 

 matrični štampači, 

 ink-jet štampači 

 piezo-električni štampači, 

 termalni i 

 laserski štampači. 
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ВВВееежжжбббааа   бббррр...777   
РРРаааддд   сссааа   лллиииссстттааамммааа   нннааабббрррааајјјааањњњааа,,,   ууубббааацццииивввааањњњеее   гггрррааафффииичччкккиииххх                                                                     

оообббјјјееекккааатттааа   ууу   тттеееккксссттт   

 

Word пружа заиста велику помоћ и при креирању листа које могу бити 
нумерисане(Numbering) и ненумерисане(знаковне Bullets). Добијају се применом 
команде Format ► Bullets and Numbering  у виду дијалога као на Слици 28. 

              

Слика 28. Дијалог прозор команде Format ►Bullets and Numbering 

 

Ако је алатка за набрајања укључена сваки нови <Enter> даће нову ознаку (број у 
растућем низу, слово по абецедном реду или ознаку по избору), док се не притисну 
два узастопна <Enter> без уноса текста, или се искључи алатка за набрајање са 
Toolbar-a. 

Картица Bulleted даје могућност избора знака који је исти за означавање сваке 
ставке у листи, а клика на Customize отвара могућност избора било ког симбола и 
дефинисања његове величине и позиције. 

Картица Numbered даје могућност избора бројева (арапских или римских) као и 
слова абецеде, при чему се у листи свака следећа ставка означава новим бројем 
односно словом у растућем редоследу. 

Последња картица Outline Numbered, нуди нумерисање у више поднивоа (по 
дубини) и комбиновање њихових стилова.  

Прозори за последње две изабране листе као и начин промена нивоа у листи 
Outline Numbered приказани су на Слици 29. 
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Слика 29. Numbered и Outline Numbered листе  

 

Промена нивоа у Outline Numbered листи постиже се једноставним притиском на 

алатке са Toolbar-a за повећање (Increase Indent)   и смањење нивоа (Decrease 

Indent)   као што је приказано на Слици 30. 

 

 
 
 

Слика 30. Команде за листе набрајања на Toolbar-у  

Поништавање акције – Undo: Нежељени ефекат наредби за форматизацију 
текста може се поништити  ако се зада наредба Edit►Undo или притиском на 
одговарајућу алатку. У листи се налази запамћени низ наредби које се могу 
поништити при чему се мора имати у виду да се поништавају све акције уназад до 
поништења акције изабране са листе (а не само изабрана акција). 
 

Враћање поништеног – Redo: Ако се погрешно поништи нека наредба ефекат те 
наредбе се може обновити командом Edit►Redo или притиском на одговарајућу 
алатку. У листи се налази списак свих акција поништених командом Undo и важи 
исто што и за наредбу Undo (поништава се скуп свих акција до оне изабране са 
листе). 
 

Понављање акције – Repeat: Одрађена акција се поред поништавања може и 
поново одрадити али само одмах по завршетку акције коју желимо да поновимо. То 
се ради избором команде Edit►Repeat. 

Алатке за укључивање и искључивање 
листи за набрајање – Numbered i Bullets 
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На Слици 31. приказани су начини одабира горе објашњених команди. 

 
 
 
   
 

Слика 31. Команде Undo, Redo и Repeat 

 
У текст можемо убацити слике различитог порекла. Једна могућност је уношење 

слика из базе Clip Art, која је саставни део Microsoft Office пакета. Друга могућност је 
убацивање датотека у одређеној форми (.JPG, .TIFF, .BMP, .GIF или сличне).  

Слика се уноси тако што се позиционирате на жељено место, а онда из менија 
Insert изабере команда Picture као што је приказано на Слици 32. 

 

 

Слика 32. Убацивање слике у документ 

Начин задавања 
команде преко менија 

Алатке Undo и Redo које се 
налазе на Toolbar-u 

Листа акција које се могу поништити 
(избором одговарајуће поништавају се све акције 
до изабране укључујући и њу) 
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Наравно слику можемо пренети из друге апликације познатим начином преко 
Clipboard-a (Copy+Paste).  

Из менија Insert избором наредбом Symbol добијамо прозор могућност да 
унесемо одговарајући симбол у текст као што је приказано на Слици 33. 

 

 

Слика 33. Убацивање симбола у документ 
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Уради Вежбу: 
 

 

1. Отворите документ formatiran.doc сачуван у претходној вежби у фасцикли ваше 
групе 

2. Форматизуј садржај на следећи начин: 

3. Величина слова нека буде 12, врста писма Arial. 

4. Побројте врсте штампача знаковном ознаком (Bullets). 

5. Побројте улазне јединице бројчаном ознаком (Numbering). 

6. Испитај примену наредби Undo и Redo на садржај документа. 

7. Преуреди параграф са излазним јединицама тако да оне буду наведене у форми 

бројчаног набрајања. 

8. Сачувај промене у документу. 

9. У оквиру 4. опције терминали додати нову поделу као доле уписани текст. 

10. Промени набрајање код излазних јединица да буде Outline. 

11. Додај код терминала нову врсту: Klasični да буде на првом месту 

12. Запази како се мењају постојеће ознаке набрајања. 

13. Сачувај документ под именом nabrajanje.doc у фасцикли ваше групе. 

14. Тексту који је написан плавом бојом промени боју у зелену. 

15. Убаци на крај документа слику по избору и постави је на средину странице. 

16. Сачувај документ под именом slika.doc у фасцикли ваше групе. 

17. Заврши рад са Word-om. 

 

 
 

4. Terminali  
 video i grafički, 
 inteligentni  
 specijalni 
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ВВВееежжжбббааа   бббррр...888   
РРРаааддд   сссааа   тттааабббееелллааамммааа   ууу   WWWooorrrddd---ооовввоооммм   дддооокккууумммееенннтттууу   

 
 
Табела представља скуп података организованих у мрежу колона (Columns) и 

редова (Rows), при чему се њихов пресек назива ћелијом (Cell). У сваку ћелију се 
могу унети текст, бројеви, слике и формуле. Ако је дужина текста већа од ширине 
ћелије, вишак текста ће бити пребачен у нови ред у истој ћелији. Сва правила и 
могућности уноса и форматирања текста важе и унутар табеле 
 
Табела се прави наредбом Table►Insert Table или коришћењем алатке са Toolbar-а 
као што је приказано на Слици 34. 

 

 

       
 
 
 

 
 

 

  

Слика 34. Креирање табеле 

 

Број колона не може да буде већи од 63, док за 
редове нема ограничења 

Подешава се ширина колоне: да ли ће све 
бити исте ширине или се ширина колоне 
прилагођава садржају ћелије 

Алатка за формирање табеле – Insert Table  

Повлачењем миша одређује се 
димензија табеле 
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Кретање из поља у поље табеле могуће је: 

 Помоћу тастера <Tab> 
 Притиском миша на ћелију 
 Помоћу дирекционих тастера 
 

Означавање целе табеле се најлакше обавља тако што у њу кликнете, а затим из 
менија Table изаберете команду Select table. Означавање колоне је једноставније 
коришћењем миша, тако што показивач поставите на горњу ивицу када се он 
претвара у малу црну стрелицу окренуту надоле кликнете. Означавање редова је 
исто као код обичног текста, показивач поставите лево од жељеног реда када се он 
претвара у нормалну стрелицу окренуту удесно и кликнете. Означавање једне ћелије 
се, такође, обавља мишем, исто као и за цео ред, али се стрелица поставља унутар 
ћелије уз њену леву ивицу, при чему се претвара у малу црну стрелицу окренуту 
удесно. Потребно је само да кликнете. Јасно, све ове операције могу означити и 
више елемената ако преко њих превучете стрелицу држећи леви тастер миша 

У менију Table налазе се команде за модификовање табеле а што је приказано 
на Слици 35: 
 
 

 

Слика 35. Листа команди из менија Table   

Када неки део табеле означите, поред форматирања његовог садржаја, можете 
да га и обришете, и то на два начина: 

 брисање садржаја, при чему структура табеле остаје нетакнута, се обавља 
простим притиском на тастер Delete или избором команде Clear из менија 
Edit,  

 брисање комплетних редова, колона или ћелија мора да се обави кроз 
избор команде Delete из менија Table у коме бирате шта бришете, или 
избором наредбе Cut. 

Када желимо да убацимо нови ред или колону, постави се курсор у ћелију поред 
које желимо нови део табеле. У менију Table►Insert бирамо:  

 Table, ако желимо да буквално убацимо још једну табелу 

Додавање нове ћелије, реда или колоне 

Брисање ћелије, реда колоне 

Селектовање ћелије, реда колоне 
или целе табеле 

Дељење и спајање ћелија 
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 Columns to the left и Columns to the right  убацују колону са леве и десне 
стране ћелије 

 Rows above и Rows below убацују ред изнад или испод ћелије. 

 Cell убацује ћелију померајући остале удесно (Shift cells right) или надоле 
(Shift cells down).  

На Слици 36. приказани су дијалог прозори које добијамо када хоћемо да 
бришемо или додамо ћелије.  

 
 

              

Слика 36. Дијалог команде Delete/Insert Cells   

 
Табела се визуелно мења коришћењем оквира и сенчења и то коришћењем 

алатки из Тoolbar-a Tables and Borders  а као што је приказано на Слици 37. 
 

 
 
  

 
 

 

Слика 37. Команде из Toolbar-a Tables and Borders 

 
 
 
 
 
 
 
 
 
 
 
 

Тип линије 
Ширина 
линије Боја линије 

 
врста оквира  

Промена оријентације 
текста у ћелији 

Поравнање текста према 
одговарајућој ивици 
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Уради Вежбу: 

 

1. Отворите нови документ. 

2. Направите табелу са четри колоне и три реда и у њу унесите ћириличним 
писмом доле приказан садржај. 

3. Величина слова нека буде 12, врста писма Verdana. 

4. Сачувај промене у документу под именом tabela.doc у фасцикли ваше групе. 

5. Додати нови ред између информатике и енглеског. 

6. Уписати у тај ред: Sociologija 30 10  33,3  

7. Форматизуј табелу на следећи начин: 

8. Спољни оквир је двострука линија. 

9. Унутрашње линије су испрекидане. 

10. Први ред има жуту позадину, а слова су плава. 

11. Подаци у последњој колони су црвене боје. 

12. Споји ћелије у првом реду у једну (Merge cells). 

13. Сачувај промене у документу. 

14. Заврши рад са Word-om. 

 

 
 

Predmet Izašlo  Položilo Procenat (%) 
Informatika 50  25  50 
Engleski 60  45  75 
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ВВВееежжжбббааа   бббррр...999   
ПППрррииипппрррееемммааа   зззааа   шшштттааамммпппууу:::   мммаааррргггииинннеее,,,   нннууумммееерррааацццииијјјааа   ссстттрррааанннааа,,,                                                   

зззаааггглллааавввљљљеее   иии   пппоооддднннооожжжјјјеее,,,   пппрррееелллоооммм   ссстттрррааанннеее   
 

 
Подешавање изгледа стране ради се помоћу команде File ► Page Setup где се 

подешавају: 

 маргине (Margins) 
 величина и оријентација папира (Paper Size) 
 начин уласка папира у штампач (Paper Source) 
 специјални распоред текста на страни (Layout) 

a што је приказано на Слици 38. 
 
 
 
 
 

        
 
 
 

Слика 38. Дијалог прозор команде Page Setup 

Картица Margins, наравно, служи за дефинисање маргина текста, које 
представљају празан простор од ивица текста до ивица папира. У одговарајућа поља 
се уносе жељени простори за горњу (Top), доњу (Bottom), леву (Left) и десну (Right) 
маргину. Маргине не треба постављати на нулу, јер практично ниједан штампач то 
не може да пренесе на папир – увек постоји простор од неколико милиметара уз 
ивице папира, који мора остати празан. 

Маргине: горња, доња, лева и 
десна, као и простор за лепак 

 

Избор за који део документа важи подешавање Величина папира 

оријентација 



Програм ѕа обраду текста – Word 

 

55

Картица Paper служи за избор величине папира на коме текст треба да се 
одштампа. Word нуди многе предефинисане формате, смештене у листи Paper, али 
ћете сасвим сигурно највише користити обичан А4 (210 x 297мм) формат. У случају 
да нема величине која вам је потребна, можете је сами дефинисати у пољима за 
ширину (Width) и висину (Height).  

Број стране се може аутоматски убацити избором команде Insert ►Page Nubers  
као што је приказано на Слици 39. 
 
 

              

Slika 39. Дијалог прозор команде Page Numbers 

 
У заглављу и подножју се могу поставити и други подаци помоћу команде View► 

Header and Footer  За разлику од већине других команди које овде примењујемо, не 
појављује се никакав посебан дијалог, већ само одговарајућа линија са алаткама као 
што је приказано на Слици 40. и поље у коме треба да дефинишете заглавље, при 
чему остатак текста избледи, стављајући вам до знања да је недоступан. 

 

 
 
 

 
 

Slika 40. Рад са Header/Footer- ом 

 
Када се дефинишу подаци за заглавље и подножје након притиска на команду 

Close текст документа ће бити поново доступан за даље измене. 

Документ се може одштампати помоћу команде File►Print или помоћу 
одговарајуће алатке из Toolbar-a.  Дијалог прозор команде File►Print дат је на 
Слици 41. 

 

Позиција може бити у подножју (Footer) или 
заглављу (Header) стране са положајем по жељи 
(лево, десно, центар) 

Број странице 
Укупан број 
страница 

Датум Време Прелаз са 
заглавља на 
подножје  

Завршетак рада 
са заглављем  
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Slika 41. Дијалог прозор команде Print 

 

Може се штампати само неки део текста. У секцији  Page Range бирамо да ли се 
штамша све (All), само страна на којој је курсор (Current Page), оно што је означено 
(Selection) или неке одређене стране, које су одвојене зарезима, а уносе се у поље 
Pages. Може се одредити и опсег који се означава нпр. 7-10.  

Ако желимо да документ одштампамо обострано, прво ћемо морати одштампати 
све непарне стране, пресложити их на одговарајући начин након штампања, поново 
вратити у штампач и, на крају, укључити штампање свих парних страна. Овај 
поступак је неопходан јер већина штампача нема могућност аутоматске обостране 
штампе. Штампање непарних страна се задаје у пољу Print, укључивањем опције 
Odd pages, а опција Even pages се односи на парне стране. 

Како ће изгледати текст када се одштампа може се видети помоћу команде File► 
Print Preview, или коришћењем одговарајуће алатке из Toolbar-a, а што је 
приказано на Слици 42.  
 

 

  
Може се изабрати: 

 приказ једне или више страна 
 увећати део документа 
 поставити лењири и маргине 

 
а након свих измена се може или  

 штампати или  
 вратити у основни приказ па штампати одатле. 

Slika 42. Опције команде Print и Print Preview 

Подешава се шта се штампа: све, 
текућа страна, селекција или неки 
опсег страница 

Одређује се број примерака који 
се штампа и начин. 
Collate штампа прво цео први 
примерак па други... а ако је 
опција искључена штампа се прво 
прва страна у одговарајућем броју 
примерака, па друга итд. ... 

Шта се штампа 
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Уради Вежбу: 

 

1. Отворите документ slika.doc сачуван у фасцикли ваше групе 

2. Форматизуј садржај на следећи начин: 

3. величина стране А4; положај папира вертикалан (Portrait); 

4. горња и доња маргина (Top и Bottom) – 1,8 cm 

5. десна и лева маргина (Right и Left) - 2 cm; 

6. простор за повезивање (Gutter) – 1 cm; 

7. растојање (From edge) заглавља (Header) и подножја (Footer) од ивице    
папира  1 сm. 

8. Sačuvaj promene u dokumentu pod imenom Margine.doc u fascikli vaše grupe 

9. U zaglavlju (View→Header and Footer) u Garamond-u, veličine slova 11, upišite 
iskošenim slovima sa desnim poravnanjem Vežba iz Osnova Informatike 

10. Numerišite stranu (Insert →Page Numbers), broj strane neka bude u centru i dnu 
strane. 

11. Sačuvaj dokument pod imenom Priprema za stampu.doc u fascikli vaše grupe. 

12. Pregledaj dokument opcijom Print Preview, a zatim se vrati u osnovni prikaz 

13. Završi rad sa Word-om  
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Одговори на питања: 

1) Документ представља: 
a) скуп програма одређене врсте 
b) скуп података одређене врсте 
c) скуп каталога одређене врсте. 

2) Формирање новог документа у активном програму врши се активирањем 
команде____________из менија_______________. 

3) Шта су фонтови? 
a) Позиви на одређену референцу у тексту. 
b) Знакови истих визуелних карактеристика. 
c) Простори између руба текста и ивице папира. 

4) Која је разлика између наредби Save и Save As? 

 

5) Опишите функције следећих тастера: 

a)  _______________________________________________ 

b)  _______________________________________________ 

c)  _______________________________________________ 

d)   _______________________________________________ 

e)  _______________________________________________ 

6) Наведите врсте прореда код уређења пасуса._______________________________ 

7) Како враћамо несталу линију алата (Toolbar)? _____________________________ 

8) Да ли је могуће истовремено радити на више докумената програма Word 
a) да 
b) не. 

9) Датотека програма Word у називу садржи наставак (екстензију)______________. 

10)  Копирање изводите алаткама ___________и___________. 

11)  Лењири служе за: 
a) кретање по документу 
b) одабир начина приказа документа 
c) подешавање маргина и обликовање пасуса. 

12)  Обликовање знакова и пасуса омогућено је пословима менија_______________. 
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13)  Nomal, Web Layout, Print Layout и Outline cy команде менија View које 
омогућавају: 
a) различите начине приказивања документа 
b) рад са више докумената 
c) различите начине приказа пасуса. 

14)  Величина и оријентација папира подешава се у дијалогу команде: 
a) Print из менија File 
b) Page Setup из менија File 
c) Paragraph из менија Format. 

15)  Растојање између редова текста подешава се у дијалогу команде: 
a) Paragraph из менија Format 
b) Font из менија Format 
c) Print из менија File. 

16)  Да би стране документа биле нумерисане активираћете команду________из 
менија ____________. 

17)  Активирањем алатке Justify на палети Formmating: 
a) поравнаћете обострано текст у односу на ивице 
b) поравнаћете централно текст у односу на ивице 
c) поравнаћете на десно текст у односу на ивице. 

18)  Ефекат сваке команде за измене у тексту може се поништити ако се aктивира 
команда____________из менија_____________ . 

19)  Обнављање дејства поништене команде могуће је активирањем алатке________ 

20)  Избор   фонта,   величине   и   стила   слова   врши   ce   y  дијалог   прозору  
команде ____________ из менија_____________. 

21)  Табелу креирате активирањем команде____________ подменија ____________ 
менија _______________. 

22)  Нови ред уметнућете у табелу командом: 
a) Rows Above 
b) Column Below 
c) Column Above 

подменија Insert из менија Table. 

23)  Повлачење маргина колона табел на хоризонталном лењиру омогућава промену: 
a) ширина колона 
b) висина колона 
c) ширину рeда. 

24)  Означене ћелије спајају се у једну командом________ из менија __________. 

25)  У пољу Gutter дијалог прозора команде Page Setup подесићете: 
a) положај заглавља у односу на ивице 
b) величину простора за повезивање (лепак) 
c) положај папира. 
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26)  Најпрецизнију слику о томе како ће изгледати документ када буде одштампан 
пружа комада из менија File: 
a) Print 
b) Print Preview 
c) Page Setup 

27)  У пољу Print истоимене команде из менија File могуће је одабрати штампање свих 
страна документа, само________или само_________страна. 

 



 

 

ПППрррооогггррраааммм   зззааа   тттааабббееелллааарррнннеее   пппрррооорррааачччууунннеее   –––   EEExxxccceeelll   
 
 
Садржај је обрађен кроз четри вежбе које обухватају: 
 
 Основне појмове и покретање 

програма 
 Радни лист и радна свеска 
 Унос и форматизација података у 

ћелијама 
 Промена ширине колоне и висине 

реда 

 Убацивање и брисање ћелија, 
колона и редова 

 Уређење табеле 
 Рад са формулама и функцијама 
 Креирање и уређење графикона 
 Практичне вежбе 
 Питања 

 
 
 
 

ВВВееежжжбббааа   бббррр...111000   
ОООссснннооовввннниии   ееелллееемммееенннтттиии,,,   уууннноооссс   иии   ииизззмммееенннааа   пппооодддааатттааакккааа,,,      аааууутттооомммааатттссскккооо   

пппооопппуууњњњааавввааањњњеее   ---   сссееерррииијјјеее   иии   лллиииссстттеее      

   
Spreadsheet програми, тј. програми за унакрсна израчунавања, су у многоме 

помогли да персонални рачунари стекну своје место на тржишту и постигну успех 
који данас имају. Програм Excel је, захваљујући графичком радном окружењу 
Windows-a, као и интеграцији са текст процесором Word, базом података Access и 
неким другим програмима у пакет Microsoft Office,  најпродаванији програм своје 
врсте на свету. Пошто је намењен најширем кругу корисника, подразумева се да се 
Excel-ови велики потенцијали могу искористити и без икаквог програмирања - 
нарочито у погледу рада са формулама и базама података, као и у представљању у 
облику графикона и табела и њиховом улепшавању. 
 

Активирање и напуштање програма Excel је на стандардни начин: 

 Каскадни менi  Start  Programs  Microsoft Excel 
 Активирање иконе на радној површини (ако постоји) 

 
Основни елементи су: радна свеска (workbook),  радни листови (worksheet) и 

ћелија (cell). 

Приликом стартовања програма Excel у прозору је приказан документ који називамо 
радном свеском (књигом - workbook) са приказаним тренутно активним радним листом 
(worksheet). Сваки радни лист је практично засебна целина, која се састоји од мреже 
колона (означених словима абецеде) којих максимално може бити 256 и редова 
(означених бројевима) којих може максимално бити 65536. У пресеку редова и колона 
налазе се ћелије (cell) које предстабљају најмању радну јединицу Excel-a. Свака ћелија 
има једнозначну адресу која се састоји од слова колоне и броја реда у којима се налази 
(A1, B8...). Између ћелија могу се дефинисати одређене везе, тако да се измена 
садржаја једне ћелије одражава и на садржаје с њом повезаних ћелија. Подаци и 
формуле се уносе у ћелије и тако се формирају радни листови. Њихов број се може 
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мењати до највише 256, а иницијално је постављен на 3. Основни елементи прозора 
програма Excel приказани су на Слици 43.  

 

 

Слика 43. Изглед основног прозора програма Excel 

Рад са документом је на већ раније описан (стандардни) начин који ће овде бити 

само укратко поновљен: 

Отварање новог документа: 

 Команда File  New 

  

 

Отварање постојећег документа: 

 Команда File  Open  

  

 
Чување документа: 

 Команда File  Save  (чува под постојећим именом)  

 Команда File  Save  As (увек отвара прозор за име) 

  
 

 а што је приказано на Слици 44 

Картице радних 
листова - Tab 

Линија за унос и измену  
садржаја ћелије  Заглавље 

колона 

Заглавље 
редова 

Поље Name у којем се приказује 
референца активне ћелије 

Активна 
ћелија 

Статусна линија 

Траке за кретање  
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Слика 44. Изглед дијалог прозора команди New и Save As  

Са радним листовима се рукује умногоме као и са самим ћелијама - могу се 
означавати (select), копирати или премештати у оквиру једне или више радних 
књига. Селекција радног листа је једноставна – кликне се мишем на жељену картицу. 
Ако их има пуно, па се не виде сви, са леве стране су стрелице за њихово 
померање. Ако је потребна селекција неколико радних листова, постоје два начина: 
уколико желимо да означимо неколико суседних листова кликнемо на први, а затим 
држећи притиснут Shift, на последњи у групи. За несуседне листове селектујемо 
њихове табове држећи притиснут тастер Ctrl.  

Додавање (insert) нових листова се обавља тако што се изабере онај испред кога 
се жели убацивање новог, затим се отвори Insert мени и изабере Worksheet. Брише 
се тако што се нежељени листови означе и изврши Delete Sheet команда из менија 
Edit. Премештање и копирање се изводе на сличан начин - означавањем праћеним 
са командом Move or Copy из менија Edit. Затим се у дијалог прозору унесе у коју 
књигу листови иду и испред ког листа се убацују. Ако се жели копирање а не 
премештање, само се кликне на 'Create a Copy' квадратић. Други начин за ове 
операције је вуци-и-спусти' (drag and drop): означе се табови листова које желимо 
да преместимо, и онда се мишем "одвуку" на жељено место. Копирање се изводи на 
исти начин само уз притиснут тастер Ctrl при одвлачењу. Промена имена радном 
листу ради се тако што се дупло кликне на његово име и унесе ново или опцијом 
Rename са помоћног менија. На помоћном менију се налазе и горе поменуте 
команде а што је приказано на Слици 45.  

   

Слика 45 Селекција радног листа, команде на помоћном менију, дијалог 
прозор команде Move or Copy   
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Ако је потребно, радни листови се могу привремено и "сакрити" помоћу команде 
Format ► Sheet ►Hide, а касније их вратити са Unhide.  

Кретање мишем по документу је на потпуно исти начин као и у осталим Windows 
апликацијама. Постоји и могућност директног "скока" на жељену ћелију –  притиском 
на F5 (иди на) директно уносимо њену адресу или уносом референце у поље Name. 
Омогућено је референцирање на ћелије и области које се налазе на другом радном 
лист или чак и у другом фајлу.  

Мењање садржаја ћелије могуће је: 

 дупли клик на ћелију 
 променом у линији за унос када је ћелија активна 
 притиском на  функцијски тастер F2 када је ћелија активна 

Завршетак рада је притисак на тастер Enter (прихватање ) или Esc (одустајање 
од измена ).  

Брисање садржаја ћелије: 

 притисак на <Backspace> или <Delete> на тастатури - брише садржај 
активне ћелије или селектованих ћелија  

 притиском на десни тастер миша и избором Clear Contents  

Брисање ћелија: 

 Команда Edit  Delete  
a што је приказано на Слици 46. 

 

       

Слика 46. Команде за брисање ћелија (Delete) или њиховог садржаја (Clear) 

Копирање (copy) и премештање (move) садржаја ћелија ради се потпуно исто као 
у свакој Windows апликацији. При смештању података на нову локацију сав ранији 
садржај циљних ћелија биће уништен.           

 
 
 



Програм ѕа табеларне прорачуне – Excel 

 

65

Прављење серија података: 

Веома корисна функција Excel-а је попуњавање (fill) суседних ћелија сродним 
садржајем, као што су имена дана у недељи или месеци у години, или једноставно 
убацивање редних бројева. Када желите да попуните већи број ћелија истим 
садржајем, довољно је да га откуцате само у једној. Затим миша доведете изнад ње 
и превучете је (притиском на леви тастер) преко оних које желите да попуните. Онда 
из Edit менија изаберите Fill и из његовог подменија смер у коме желите 
попуњавање - биће прекопиран садржај и формат почетне ћелије. Ова врста 
копирања може да се изведе и из једног радног листа у друге. За копирање садржаја 
и формата ћелије се бира All, само за садржај Contents а само за формат Formats, 
праћено наравно са Ok. 

За разлику од функције Fill која само копира садржај, AutoFill је много 
"паметнији", тако да ако, рецимо, желимо да унесемо дане у недељи, довољно је да 
откуцамо само први дан  (Monday) и повучемо "ручицу за попуњавање" (има је свака 
означена ћелија, представља је мали квадрат у доњем десном углу) у жељеном 
смеру. Када се миш доведе изнад њега, стрелица се претвара у мали знак '+'. По 
отпуштању дугмета на мишу, Excel ће сам попунити додатне ћелије одговарајућим 
данима Сличне листе можемо креирати и сами, потребно је урадити следеће: У 
Tools менију изаберемо Options, па затим Custom Lists таб. Кликом на ставку NEW 
LIST, курзор се појављује у List Entries пољу. Унесемо ставке листе и притиском на 
Add (када можете дефинисати још неку листу), или OK завршавамо унос, а што је 
приказано на Слици 47. 

 

   

Слика 47. Попуњавање (fill) и унос нове листе 

Креирање серије је веома једноставно: унесе се вредност у почетну ћелију, 
означе се ћелије које треба попунити и из менија Edit  изаберемо команду Fill► 
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Series. Изаберемо да ли се серија шири по колони или реду, врсту серије и корак 
(Step value) и зауставну вредност (Stop value) као што је приказано на Слици 48.  

У већини случајева Excel ће схватити шта се жели и самим повлачењем ручице 
за попуњавање. 

 

Serija Inicijalni 
podaci 

Rezultujuća serija 

 

Linearna 1,2 3,4,5 

100,99 98,97,96 

1,3 5,7,9 

Porast 
(Growth) 

10  

(korak 5) 

50, 250, 1250 

10 

(korak 10) 

100, 1000, 10000 

Datum Mon Tue, Wed, Thur 

Feb Mar, Apr, May 

1995 1996, 1997, 1998 

AutoFill Team 1 Team 2, Team 3, Team 
4 

Qtr 4 Qtr 1, Qtr 2, Qtr 3 

1st Quarter 2nd Quarter, 3rd 
Quarter, 4th Quarter 

Слика 48. Команде за прављење серија различитих типова 
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Уради Вежбу: 

1. Направите нови документ програма Excel. Прегледајте делове прозора 
програма Excel и проверите да ли су на прозору присутне: 

 стандардна палета са алаткама; 

 палета са алаткама за форматирање; 

 линија за уписивање садржаја; 

 статусна линија. 
 

Празној радној свесци доделите име Prva и сачувајте је у фолдеру  Excel који 
ћете направити у фолдеру ваше групе.  

 
2. У документу Prva: 

 промените имена радних листова:Sheet1 у Podaci,  Sheet2 у Tabela. 

 Уклоните радни лист Sheet3. 
Сачувајте овако измењени документ. 
 

3. На радном листу Podaci: 

 У ћелију В1 упишите:  Име и презиме (ваше име и презиме) 

 У ћелију В 2 упишите: Место и година рођења  

 У D7 – 12345;  F11 – 2009.  
 

4. Додајте нови радни лист и подесите да буде последњи. Промените му име у 
Automatsko popunjavanje. 

   
5. У радном листу Automatsko popunjavanje увежбајте копирање садржаја 

ћелије у суседне ћелије истог реда или колоне, повлачењем ручице за 
копирање. Пробајте са следећим садржајем: 

 Једне ћелије: а) 2000;  б) Испит 1;  в) Sunday;  г) Feb. 

 Две суседне ћелије: а) 2000 и 2002;  б) 1990 и 1995;  в) ДАН и МЕСЕЦ. 
 
 
Сачувајте измењену радну свеску Prva. 
 
 
 
 
 
 
 
 
 

 



Основи рачунарске технике и програмирања  - Практикум 

 

68

ВВВееежжжбббааа   бббррр...111111   
ФФФооорррмммааатттииирррааањњњеее   сссааадддррржжжааајјјааа   ћћћееелллииијјјеее,,,   пппрррооомммееенннааа   шшшииирррииинннеее   кккооолллооонннеее   иии   

вввииисссииинннеее   рррееедддааа,,,      
 

 
Садржај који је унет у неку ћелију (или скуп ћелија) можемо форматирати 

избором команде  Cell менија  Format. Добија се прозор са више картица приказаних 
на Слици 49. 
 
формат броја:      изглед фонта:   

   број децималних места и формат    назив, стил, величина,  
    негативних бројева          боја и специјални ефекти  
 

                    
 
формат датума:  поравнањe и оријентацијa текста: 
  тип приказа датума    хоризонтално, вертикално, 
     оријентација текста и прелом текста 
 

                 

Слика 49. Опције које се могу подешавати избором команде Format Cell 
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Ту је и дијалог за оквире (Border), при чему и на линији са алаткама можемо наћи 
одговарајуће команде као што је приказано на Слици 50. 
 

            

Слика 50. Подешавање оквира 

Промена ширине колона и висина редова подешава се: 
 из менија Format: 

Ширина колоне: Format  Column  Width 
   Висина реда: Format  Row  Height 

                          
           Задавање ширине колоне  Задавање висине реда 
 
 мишем тако што се поинтер примакне заглављу, а затим повуче жељена ивица  

                 
            Мењање ширине колоне G, и реда 6. 
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Уради Вежбу: 

1. Отворите радну свеску Prva коју сте формирали у претходној вежби. 

На радном листу Podaci форматизуј унети садржај на следећи начин: 

 У ћелију В1 где пише Име и презиме (фонт: Arial, подебљана, 
закошена слова, величина 15 pt, ћирилица) ,централно поравнање. 
Промени ширину колоне да се види цео текст.  

 У ћелију В 2 где пише  Место и година рођења (фонт: Verdana, 
подебљана слова величине 10) и оријентација текста вертикална (900). 

 У D7 – 12345, поравнање централно, боја бројева црвена 

 У  F11 – 2009, поравнање лево, боја у ћелији жута, боја бројева зелена. 
 

2. На радном листу Tabela направите доле приказану табелу и форматирајте је 
на приказан начин. 

 

 
 

3. Промени спољни оквир табеле да буде двострука линија.  

4. Сачувајте овако измењени документ под новим именом Druga у истом 
фолдеру где је био документ Prva. 
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ВВВееежжжбббааа   бббррр...111222   
ИИИзззрррааадддааа   иии   уууррреееђђђееењњњеее   дддииијјјааагггрррааамммааа   (((гггрррааафффииикккооонннааа)))      

 

 

Графикон представља графички (визуелни) приказ вредности садржаних у 
табели. Пре почетка рада са графиконима, објаснимо нове термине које ћемо 
користити: 

Data Series – серије података чине групе података повезаних неким релацијама  
(обично је то само један ред или колона табеле или радног листа). 

Axis – оса, представља једну страну графикона. У дводимензионалном имамо x-осу 
(хоризонталну) и y-осу (вертикалну), а у тродимензионалном графикону 
z-оса представља вертикалу, а x-оса (одстојање) i y-оса (ширина) 
представљају две стране "пода". 

Legend – легенда, дефинише значење разних делова графика. 

Да бисмо креирали графикон, прво морамо селектовати податке које желимо 
приказати графички, а сам поступак израде дијаграма (chart) u Excelu могућ је на 
неколико начина:  

 Притиском на функцијски тастер F11 графикон се креира на посебном листу; 
  Из менија Insert наредбом Chart; 

  Помоћу Excelovog чаробњака (Chart Wizard) из линије са алаткама  .  

Уз помоћ чаробњака графиком креирамо кроз 4 корака:  

1. Бирамо тип графикона Chart Type, где ако нисмо нашли одговарајући у 
стандардној понуди избором Custom Types добијамо додатне графиконе 
изведене из стандардних. Притиском на дугме Press and Hold to View 
Sample, видећемо умањен приказ изабраног графикона базираног на 
селектованим подацима, а што је приказано на слици 51. 

 

             

Слика 51. Први корак: избор типа дијаграма 
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Постоји приличан број разноврсних предефинисаних типова графикона. 
Основне групе су:  

- Column (вертикални стубичасти дијаграм -хистограм), 

- Пие (пита, кружни дијаграм који се користи за приказивање релација између 
делова целине за једну серију података),  

- Line (линијски дијаграм најбоље приказује трендове и промене које се 
јављају током времена),  

- Bar (хоризонтални тракасти дијаграм који је 'заокренути стубичасти 
дијаграм'),  

- Area (области, служе за приказивање промене у вредностима). 

Већину основних типова можете представити у тродимензионалном облику. 

2. Притиском на тастер Next,  долазимо до дијалога где одређујемо опсег 
података који ће бити приказан графиконом Chart Source Data. Ту одређујемо 
и да ли се серије налазе у редовима или колонама. Ако смо у старту 
направили погрешну селекцију података можемо је исправити директним 
куцањем у поље Range, или поновним превлачењем мишем преко жељене 
области (ако приказани дијалог смета, кликните мишем на икону са црвеном 
стрелицом у углу поља за опсег и дијалог ће се смањити – величину му 
враћате истим кликом). На картици Series можемо дати имена серијама 
података, а што је приказано на Слици 52. 

 

          

Слика 52. Други корак: избор опсега података 

3. Избором Next долазимо до опције Chart Options где можемо подешавати 
следеће опције графикона:   

- Titles нуди могућност насловљавања графикона, као и давања имена осама; 

- Axes омогућава укључење исписа натписа поред оса; 
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- Gridlines служи за укључење главних и споредних линија мреже по све три 
осе; 

- Legend омогућава приказивање легенде као и њено позиционирање на 
графикону; 

- Data Labels укључује исписивање имена или вредности уз сваки део 
графикона; 

- Data Table, омогућава укључивање табелу са вредностима испод графикона. 

Неке од ових опција приказане су на Слици 53. 

 

    

Слика 53. Трећи корак: подешавање опција дијаграма 

4. Поновним избором Next долазимо до последњег корака Chart Location и 
дијалога у коме бирамо да ли ће се графикон појавити на новом радном листу 
креираном само за њега, или на неком од постојећих. Притиском на тастер 
Finish  завршавамо креирање графикона као што је приказано на слици 54. 

 

 

Слика 54. Четврти корак: избор локације дијаграма 

Графикону се може по вољи мењати величина ручкама на срединама страна као 
и у његовим теменима, а може се и вући и постављти на жељено место.  

Кликом на графикон можемо га учинити активним и мењати његову 
форматизацију, или чак додавати нове или избацивати постојеће серије података. То 
радимо на следећи начин: означимо ћелије у табели, укључујући и имена категорија 
и серија података које желимо да додамо. Одвуче се мишем жељена област на 
жељену позицију на дијаграму и посао је готов. Ако је потребно неку серију избацити, 
само се на њу кликне и затим притисне тастер Delete.  
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Уради Вежбу: 

1. Отворите радну свеску Druga коју сте формирали у претходној вежби. Додајте 
нови радни лист и доделите му име Dijagram. Сачувајте измењену радну 
свеску у фолдеру Excel у фолдеру ваше групе под именом Treća. 

 
2. Прекопирајте Табелу 1 са радног листа Tabela на радни лист Dijagram, а 

назив табеле промените у Табела 2. Прекопирана табела. На основу података 
из прекопиране табеле на истом радном листу направите стубичасти дијаграм 
који приказује зависност броја прекршаја (за сваку врсту) од дана у седмици. 
Дијаграм треба да садржи наслов, називе координатних оса исписаних 
ћирилицом и легенду постављену на дну.  

 
3. На новом радном листу Tipovi dijagrama формирајте табелу састављену од 

претколоне и колоне СН, Табеле 1. Назив табеле треба да буде:  
Табела 3. Саобраћајне незгоде. Направите три дијаграма на основу података 
из ове табеле: 

 стубичасти; 
 линијски и 
 прстенасти. 

 
4. Сачувајте измењену радну свеску.  
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ВВВееежжжбббааа   бббррр...111333   
РРРаааддд   сссааа   фффооорррмммууулллааамммааа   иии   фффууунннкккцццииијјјааамммааа,,,   оообббрррааадддааа                                                                                                   

пппооодддааатттааакккааа   ууу   тттааабббееелллиии      

 

Основна намена Excel-а су табеларна израчунавања. Да би нешто могло да се 
рачуна, треба задати формуле зависности одговарајућих ћелија.  

Формула: Једначина у којој се над подацима унетим у радни лист извршавају 
операције као што су сабирање (+), одузимање (-), множење (*) и дељење (/). 

Формуле увек почињу знаком (=), и увек треба притиснути тастер Enter да би 
потврдили формулу. Компоненте формуле се називају аргументи и они могу бити 

референце ћелија или бројеви (константе). Редослед извршавања рачунских 
операција не разликује се од стандардне математике. 

Формула се уноси куцањем или означавањем адреса ћелија. Прво означите 
ћелију у којој желите да се појави резултат. Затим куцате знак једнакости (=) који 

Excel-у говори да ћете унети формулу, а за њим и саму формулу. Резултат се 
израчунава чим притиснете Enter.  

Други начин је у ствари исти, с том разликом да не уносите ручно адресе ћелија 
које садрже операнде, већ их селектујемо мишем а Excel сам уписује адресе. Овако 

се могу уносити како адресе појединачних ћелија тако и области (превлачењем). Ако 
желите да прекинете унос и занемарите откуцани део, довољно је да притиснете 

Esc.  

Исте операције могу се обавити и у посебном пољу за унос формула (Formula 

bar). Лево од поља за унос су тастери са ознакама 'X' i ' ' који имају исту улогу као и 
тастери Esc i Enter, а што је приказано на Слици 55. Ту је и тастер са ознаком 'fx' 

који активира додатни алат за уношење сложених формула – функција. 

 

    

Слика 55. Приказ уноса формуле у ћелију 

Укуцати формулу користећи поинтерски 
режим рада: 
 
=A1*A2-A3+A4*A5/A6 
 
Израчуната ћелија је ћелија која садржи 
прорачун, али приказује резултат прорачуна. 
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Поруке о грешкама:  

 ####  ћелија садржи тачан податак који је сувише велик да би се приказао у 
ћелији, треба подесити ширину колоне; 

 #VALUE! Формула садржи текст (или референцу ћелије која садржи текст), а 
Excel очекује број; 

 #DIV./0! Покушали сте да делите са нулом; 

 #REF! Формула садржи референцу на ћелију која више не постоји јер је 
избрисана. 

Функција је унапред дефинисана формула, уграђена у Excel, која се користи за 
одређену намену. Навешћемо неке од најчешће коришћених функција: 
 

 SUM(number1,number2,...) или SUM(number1:number2) – где су number1, 
number2, ... од 1 до 30 аргумент типа бројчаног податка за које се рачуна збир, 
односно референца прве и последње ћелије опсега за који се рачуна сума. 
Ова функција занемарује ћелије које садрже текст или су празне. 

 
 AVERAGE(number1,number2,...) где су number1, number2, ...   од 1 до 30 

аргумент типа бројчаног податка за који се рачуна средња вредност. 
 

 MIN и MAX користимо за проналажење најмање односно највеће вредности у 
датој групи ћелија.  

 
 COUNT омогућава да у датој групи ћелија пребројимо уписане бројчане 

вредности. 
 

Када уносимо функцију прво означимо ћелију која треба да садржи резултат, 
затим уносимо функцију из менија Insert ► Function  

 

  

Слика 56. Дијалог прозор команде за унос функције 

Појављује се дијалог као на слици 56. Категорију бирамо из листе категорија 
(Select a category), тако да се у делу за функције (Select a function) појављују само 
оне које припадају тој категорији. Ова подела је врло згодна за лакше проналажење 
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жељене функције. Под категорије спадају између осталих финансијске (Financial), 
математичке (Math & Trig), статистичке (Statistical), као и посебне: скуп свих 
функција (All) или оних које су најскорије употребљене (Most Recently Used). Испод 
се налази синтакса и детаљнији опис функције која је тренутно изабрана.  
 

Када се одлучите за категорију и функцију коју желите да примените, притисните 
Enter на тастатури или тастер OK у дијалогу. Приказаће се нови дијалог који 
представља други (и крајњи) корак чији садржај зависи од аргумената изабране 
функције, а наведено је њено име и кратак опис. Могу се директно куцати адресе а 
омогућен је и унос мишем, тако што се кликне на жељену ћелију, када сам Excel 
уноси њену адресу. Као аргумент се може унети и нека друга функција. Поред поља 
у које се уносе аргументи одмах се приказује и њихова вредност, а у доњем левом 
углу дијалога је поље са називом Formula result у коме се одмах добија резултат. 
Све наведено за функцију SUM приказано је на Слици 56. 

Цела операција се завршава притиском на дугме OK, када се формула преноси у 
табелу и производи ефекат. 

 

 

Слика 56. Дијалог прозор за избор аргумената изабране функције SUM 
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Уради Вежбу: 

1. Отворите радну свеску Treća коју сте формирали у претходној вежби.  Додајте 
нови радни лист и доделите му име Formule i funkcije. Сачувајте измењену 
радну свеску у истом фолдеру под именом Četvrta. 

2. Прекопирајте Табелу 1 са радног листа Tabela на радни лист  Formule i 
funkcije и означите је са Табела 4 (прва колона табеле нека буде у колони B). 
Прекопираној табели додајте колону и ред Укупно. Форматирајте додатне 
елементе табеле, тако да буду уочљиви (обојте ћелије другом бојом). 
Израчунајте одговарајуће вредности у колони и реду Укупно.  

3. Промените вредности у Табели 4 такo дa укупан број прекршаја по врстама не 
буде једнак. Посматрајте како се мењају сумарне вредности (ћелије у којима 
су формуле) када мењате вредност ћелије у којој је аргумент.  

Додајте ред Просек и израчунајте просечан број прекршаја по врстама. 
 

4. Формирајте Табелу 5 са почетком у колони Ј тако што ћете прекопирати 
заглавље Табеле 4 и ред Укупно. Табели доделите назив Преглед прекршаја 
по врстама. Приликом копирања користите Paste Special, са потврђеном 
опцијом Values. У претколони нове табеле уместо речи Дан напишите Врста 
прекршаја, а уместо Укупно, Број прекршаја. 

 

Напомена: Табела 5 треба да изгледа слично овој: 

 

 

5. Додајте нови ред Табели 5 на следећи начин: у претколони новог реда 
напишите Заступљеност, а у ћелијама за податке израчунајте процентуалну 
заступљеност сваке врсте прекршаја у односу на укупан број. Формулу за 
израчунавање заступљености напишите тако да се може прекопирати. 

6. Сачувајте измењену радну свеску.  

7. Направите нови документ програма Excel.  Прекопирајте следећу табелу: 

Табела 1. 

Преглед броја саобраћајних незгода на подручју 
АБЦ у периоду 1996–2000. год. 

Mес. / Год. 1996. 1997. 1998. 1999. 2000. 

Јануар 1180 1315 1603 1758 1797

Фебруар 997 1100 1252 1383 1545

Март 995 1205 1301 1410 1523

Април 1142 1241 1358 1469 1648

Мај 1535 1837 2091 2084 2447
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Јун 2879 2989 3337 3428 4028

Јул 8938 9707 10753 10909 12626

Август 8219 9103 9806 9352 10022

Септембар 2652 2886 3032 3205 3522

Октобар 1394 1507 1776 1777 2202

Новембар 1055 1208 1298 1448 1626

Децембар 1030 1174 1197 1330 1440

 
Након копирања подесите изглед табелa (димензије колона и редова, 
оквири). Дајте радном листу име Mesečni pregled. Сачувајте измењену 
радну свеску у фолдеру Excel фолдера ваше групе под именом Poslednja. 

8. На радном листу Mesečni pregled: 

 графички прикажите број саобраћајних незгода за сваку годину (5 серија на 
истом дијаграму), у зависности од месеци. За тип дијаграма изаберите 
линијски. Дијаграм треба да садржи наслов, називе оса и легенду. 

 Додајте табели нове редове који ће садржати: 

 укупан број незгода током једне године (Укупно), 
 просечан број незгода (Просек), 
 максималан број незгода током године (Маx), 
 минималан број незгода током године (Min), 
 разлику између максималног и минималног броја током године 

(Распон).  

 Прикажите графички: просек, минимуме и максимуме у зависности од 
година. 

 
9. Сачувајте овако измењену радну свеску.  
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Одговори на питања: 
 
 

1) Шта је Excel? 
_______________________________________________________________________ 

2) Документ у програму Excel назива се ________________ и састоји се од радних 
листова (Sheet), којих може бiти ___________. (допуните реченицу). 

3) Који тип датотеке се користи за табеларне прорачуне (spreadsheets)? 
a) .mp3  
b) .doc  
c) .gif  
d) .xls 

4) Како се назива ова линија са алатима?     

 Линија ______________________________. 

5) Адреса (референца) ћелије представља: 
a) ознаку колоне у мрежи радне табеле у којој се налази ћелија 
b) ознаку реда у мрежи радне табеле у ком се налази ћелија 
c) ознаку положаја ћелије у мрежи радне табеле. 

6) За селектовање опсега несуседних ћелија користимо тастер : 
a) Shift 
b) Ctrl 
c) F2 
d) Alt 

7) Када се притисне тастер Delete на тастатури, брише се садржај ћелије и сама 
ћелија 
a) Тачно 
b) Нерачно 

8) Поље Name приказује: 
a) Референцу ћелије која је тренутно активна 
b) Име радне свеске 
c) Име радног листа 
d) Ваше име 

9) Excel-ов тастер за едитовање садржаја ћелије (Edit) је: 
a) Alt 
b) F2 
c) Insert 
d) Ctrl 

10)  Нови радни лист додаћете командом___________из менија ________________. 

11)  Радни лист премештате командом ____________________из менија Edit. 
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12)  Уклањање ћелија извршавате командом: 
a) Clear из менија Edit 
b) Delete из менија Edit 
c) Cells из менија Format. 

13)  Сваки прорачун или математичка формула почиње знаком __________________  
(доврши реченицу). 

14)  У формули се може употребити само један оператор 
a) Тачно 
b) Нетачно 

15)  У формулама се могу користити: 
a) само бројне вредности 
b) бројне вредности и адресе ћелија 
c) само адресе ћелија. 

16)  Копирање редова у колоне и колона у редове табеле омогућава потврда 
опције ___________________у дијалогу команде Paste Special. 

17)  Ако измените вредност у ћелији, морате поново унети све формуле у којима се та 
ћелија референцира да би се поново израчунала њихова вредност? 
a) Тачно 
b) Нетачно 

18)  Функција SUM ће јавити грешку ако један од њених аргумената није број 
a) Тачно 
b) Нетачно 

19)  Алатку Autofill можете употребити за: 
a) Копирање бројева и текста у суседне ћелије 
b) Инкрементално копирање месеци у години и дана у недељи у суседне ћелије 
c) Копирање формула у суседне ћелије 
d) Све претходно 

20) Функција AVERAGE рачуна: 
a) аритметичку средњу вредност аргумената 
b) разлику аргумената 
c) суму аргумената. 

21)  Шта ради функција MAX? _____________________________________________ 

22)  Шта означава низ повисилица (####) у ћелији?____________________________ 

23)  Навести најмање два начина за креирање графикона: 

 

24)  Диј аграм ј е могуће сместити: 
a) искључиво у радни лист у ком се налази табела 
b) у нови радни лист или у неки од постојећих 
c) само у нови радни лист. 
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25)  Да ли је могуће мењати тип дијаграма после завршене израде: 
a) не 
b) само код неких типова дијаграма 
c) да. 

26)  Тракасти дијаграм може садржати: 
a) Само једну тачку података 
b) Само једну серију података 
c) Више серија података 
d) Више цртежа 

27)  Ако се промени садржај извора података на основу којег сте направили дијаграм, 
морате поново направити дијаграм из почетка да би био ажуран 
a) Тачно 
b) Нетачно 

28)  Кружни дијаграм може садржати: 
a) Само једну тачку података 
b) Само једну серију података 
c) Више серија података 
d) Више цртежа 

29)  Прозор за дијалог Chart Source Data садржи картице: 
a) Patterns и Font 
b) Standard Types и Custom Types 
c) Data Range и Series. 

 
 



 

 

МММрррееежжжеее   иии   ИИИнннтттееерррнннеееттт   

 
Садржај обрађен у две вежбе обухвата: 
 
 Активирање програма Internet 

Explorer 
 Преглед садржаја на одређеној 

Интернет адреси 
 Чување садржаја странице са 

изабране Интернет адресе 
 Коришћење Интернет 

претраживача 
 Коришћење сервиса електронске 

поште (E– mail) 
 Рад са програмом Outlook Express 
 Питања 
 Практична вежба 



 

 

 

   
ВВВееежжжбббааа   бббррр...111444   

ОООссснннооовввнннеее   уууссслллууугггеее   IIInnnttteeerrrnnneeetttaaa,,,   IIInnnttteeerrrnnneeettt   EEExxxppplllooorrreeerrr,,,   пппрррееетттрррааажжжииивввааањњњеее   

пппооодддааатттааакккааа,,,      
 

Интернет представља велики број повезаних рачунара који међусобно 
комуницирају, у једну глобалну мрежу рачунара. Они за то користе посебне језике – 
протоколе, а за Интернет је (из много разлога) главни протокол постао TCP/IP 
(Transmision Control Protocol/Inernet Protocol). У мрежи тих рачунара постоје 
опслужитељи (Server) и корисници (Client) и то је основа концепта који се назива 
клијент/сервер архитектура. Рачунари који садрже информације, са којих остали 
могу да их читају називају се сервери. Са друге стране, клијенти су они који их 
читају. Сервери се обично не искључују (осим када се врши њихов сервис), док 
клијенти, када треба да прочитају нешто,  морају да се повежу на мрежу.  

Термин »Прикључени на Интернет«, у ствари значи да сте успоставили везу са 
неким од сервера. Уобичајено је да се веза успостави преко модема, уређаја који 
повезује рачунаре користећи ресурсе обичне телефонске линије, међутим могући су 
и други начини конектовања (кабловски, безжично...). Приликом повезивања на 
Интернет рачунар добија своју јединствену IP (Internet Protocol) адресу. Ту адресу 
чине четри скупа бројева (0-255) одвојених тачком. Ради лакшег памћења адреса 
уведен је DNS (Domain Name Server) систем који преводи број у текст и обратно, 
тако да уместо да пишемо нумеричку адресу просто упишемо име у текстуалном 
облику нпр. www.kpa.edu.rs (адреса Криминалистичко полицијске академије). 

URL (Uniform Resource Locator) је јединствена Web адреса која садржи име Web 
сервера и укључује (или подразумева) и име одређене Web стране. Када у URL 
адреси није назначена страна, читач приказује подразумевану страну, обично страну 
index.html. 

Два најчешће коришћена (неки би рекли и најбитнија) сервиса Интернета су 
WWW (World Wide Web) за графички хипертекстуални приказ садржаја и E-mail 
(електронска пошта). 

Многи корисници Интернета често изједначавају WWW сервис са Интернетом. 
WWW је мултимедијални сервис који почива на HTTP (HyperText Transfer Protocol) 
протоколу и  HTML (HyperText Markup language) језику. Да бисте користили сервис 
WWW потребно је да имате неки web читач (web browser). Постоји их много а 
најпопуларнији су Internet Explorer, Netscape, Opera, Firefox, NetCaptor и др.  Ви 
као корисник сами бирате који ћете користити. Употребљавају се на сличан начин а 
ми ћемо овде објаснити Internet Explorer фирме Microsoft . 

Приликом стартовања овог програма добија се екран као на Слици 57, при чему 
садржај зависи од тога коју сте страницу подесили као почетну.  

 

 

Линија 
наслова 

Линија 
менија 

Линија 
алата 

Адресна 
линија 
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Слика 57.  Web страна ВТШСС у Звечану  www.vts-zvecan.edu.rs 

У насловној линији се, поред контролног дугмета у левом углу, налази назив 
Интернет стране која је тренутно учитана, праћена називом програма. Затим имамо 
линију менија и испод ње линију са алаткама. Следи адресна линија (Address) у коју 
уписујемо адресу жељене Web стране. Конкретно на Слици 57 приказан је садржај 
Web стране Министарства Унутрашњих Послова Републике Србије www.mup.gov.rs,  
a што се може видети и у адресном пољу. Испод приказаног садржаја Интернет 
стране на самом дну налази се статусна линија у којој у облику плавог правоугаоника 
можемо видети проценат учитане стране. 

Ако смо некој страни већ приступали и не желимо да поново куцамо адресу 
приметимо да је Address поље у ствари падајућа листа из које можемо изабрати 
жељену локацију. Када смо учитали страну видећемо да се на њој налазе 
показивачи (линкови) који указују на друге садржаје (без обзира где се ти садржаји 
налазе). Кликом на линк прелазимо на страницу са тим садржајем и тако поново 
идемо за информацијом која нам треба. Овакав механизам назива се хипертекст, јер 
се у њему једноставно дефинишу хиперлинкови. Они се од околног текста разликују 
по томе што су подвучени и кад се поставимо мишем на неки од њих у статусној 
линији се види локација на коју он показује а стрелица мења облик у шаку са 
испруженим кажипрстом. Показивач не морате пратити у текућем прозору, довољно 
је на њега кликнути десним тастером миша и изабрати да се отвори у новом прозору 
(Open in New Window).  

Линија са алткама нуди најбитније навигационе команде као што је приказано на 
Слици 58. 
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    1   2   3       4         5                 6           7      8      9   10   

Слика 58.  Линија алата програма Internet Explorer 

1. Прва два тастера на левој страни служе да се крећете назад (Back) и напред 
(Forward) за по једну већ посећену локацију (учитану страницу). 

2. тастер (Stop) којим се прекида учитавање стране; 

3. тастер за поновно учитавање исте стране (Refresh); 

4. тастер за скок на страну која је дефинисана као почетна (Home). Ова страна 
се иначе аутоматски учитава одмах по стартовању IE-a.  

5. тастер којим отварамо мени са сервисима за претраживање Интернета по 
кључној речи (Search); 

6. тастер за приказивање списка омиљених локација (Favorites); 

7. тастер за приказивање списка већ посећених локација (History); 

8. тастер којим се омогућава рад са електронском поштом (Mail); 

9. тастер за штампање стране (Print); 

10. тастер за едитовање стране у неком програму нпр. Front Page (Edit). 

Укључивање и искључивање линија са алаткама могућ је преко менија 
View/Toolbars. 

Листу омиљених локација можемо проширити тако што по учитавању одабране 
стране изаберемо опцију Add to Favorites из менија Favorites. 

Претраживање садржаја могућ је и коришћењем тзв. search engin, тј. машина за 
претраживање које претражују садржај Интернета по задатом критеријуму и дају 
листу резултата. Најпознатије машине су Google, Yahoo, Altavista и др.  

Уколико желимо да сачувамо приказани садржај бирамо команду Save As из 
менија File. Формати у којима можемо снимити страну су: 

 Web Page complete (htm, html), Web Archive single file (mht)– када снимамо 
документ са свим елементима (слика, анимација, звук..);  

 Web Page HTML only (htm, html) – када снимамо страну као HTML документ; 

 Text File – када je чувамо као обичан текст. 

Ако користимо помоћни мени неког показивача можемо садржај на који показује 
сачувати и без отварања тако што ћемо изабрати опцију Save Target As. Ове опције 
приказане су на Слици 59. 
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Слика 59. Формати у којима је могуће чувати одређену страну 
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Уради Вежбу: 

1. Активирај програм Internet Explorer ili Google Chrome.  

2. Посетите Web локацију школе  http://www.vts-zvecan.edu.rs   

3. Прегледај садржај презентације коришћењем понуђених показивача (линкова).  

4. Пронађи податке везане за распоред наставе. 

5. Сачувај на диску D: у посебном фолдеру распоред наставе за ваш смер. 

6. Иди на фото галерију и сачувај слику по избору у исти фолдер. 

Одговори на питања: 

1) Шта је Internet?___________________________________________________ 

2) Који протокол је задужен за правилан проток података? ___________________ 

3) Која хардверска компонента рачунара је потребна да би се он повезао преко 
телефонских линија на Интернет? _____________________________________ 

4) Адреса рачунара по којој је препознатљив у мрежи је: 
a) FTP  
b) SMTP 
c) IР 

5) Правила којима је регулисана размена порука између чворова у мрежи 
регулисана је протоколом: 
a) FTP 
b) SMTP 
c) TCP/IP 

6) Интернет сервис који чини доступним корисницима огроман број текстуалних, 
аудио и визуелних докумената зове се: 
a) IRC 
b) Newsgroup 
c) www. 

7) Запис облика http://www.kpa.edu.rs/index.html представља: 
a) IRC  
b) SMTP 
c) URL. 

8) Листу омиљених локација можемо проширити или их организовати из менија 
____________________________________? 

9) Списак    раније    посећених    Web    страна    прегледаћете    активирањем    
алатке _______________________________. 

10)  Изабрану у Web страну сачуваћете активирањем команде________из менија 
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____________________. 

11)  Одабрани документ са „мреже" можете сачувати без отварања командом: 
a) Save Target As из помоћног (приручног) менија одговарајућег показивача 
b) Print Target из помоћног менија одговарајућег показивача 
c) Add to Favorites из приручног менија одговарајућег показивача. 

12)  Како се враћате уназад кроз већ посећене странице? 
a) Притиснете тастер Page Up 
b) Притиснете тастер Forward 
c) Притиснете тастер Back 
d) Притиснете тастер Go 

13)  ____________________је приватна мрежа компаније базирана на Интернет 
технологији. Допуните дефиницију 
a)  The World Wide Web (WWW) 
b)  An ADSL 
c)  The Internet 
d)  An Intranet 

14)  Рачунар који комуницира са сервером у локалној рачунарској мрежи познат је као: 
a)  mail server 
b)  file server 
c)  PDA 
d)  client 

15)  Шта је World Wide Web (WWW)? 
a) Светска услужна дигитална мрежа 
b) Врста софтвера који корисницима широм света омогућава преглед 

хипертекстуалних докумената 
c) Скуп светских мрежа 
d) Скуп хипертекстуалних докумената смештених на HTTP серверима широм 

света 

16)  _______________________је глобална светска рачунарска мрежа 
a)  Internet 
b)  extranet 
c)  intranet 
d)  World Wide Web 

17)  Шта је машина за претраживање (Search Engine)?  
a) Програм који тражи вирусе на Web страници  
b) Програм који тражи везу са Интернетом  
c) Програм који освежава Web странице  
d) Програм који претражује Интернет по кључним речима 

18)  Шта је почетна страница у Web претраживачу (браузеру)  
a) Прва страница на некој Web локацији  
b) Систем помоћи Web претраживача  
c) Хипервеза до документа  

d) Страница која се отвара одмах при покретању Web претраживача 
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ВВВееежжжбббааа   бббррр...111555   
EEEлллеееккктттрррооонннссскккааа   пппооошшштттааа,,,   OOOuuutttlllooooookkk   EEExxxppprrreeessssss      

 

Електронска пошта (E-mail) је један од најстаријих и најчешће коришћених 
сервиса на Интернету. Сервис обезбеђује слање и пријем порука, непревазиђен је у 
флексибилности и брзини, а једну те исту поруку можете послати неограниченом 
брију примаоца. Нажалост, ни овај систем није 100% поуздан. Комуникацију 
остварујемо преко јединствених електронских адреса. Електронска адреса 
идентификује особу на одређеној локацији Интернета и састоји се од два дела. Први 
део који сами одређујемо чини корисничко име особе, а други – даваоца услуге е-
поште или домен у коме се пошта прима и чува. Значи можемо рећи да је њен облик 
корисничко_име@адреса_рачунара – где је корисничко име идентификација 
корисника на E-mail серверу, а адреса рачунара, симболичка адреса рачунара ( E-
mail сервера) на Интернету. У адреси несме постојати празно место. 

Постоје многи програми намењени за слање и примање електронске поште, а 
један од најпопуларнијих је Outlook Express, испоручује се уз Internet Explorer, са 
чијом верзијом 6 ћемо се ближе упознати. На Слици 60 је приказан радни прозор 
овог програма 

 

 

Слика 60. Радни прозор програма Outlook Express 

Стандардне делове прозора нећемо објашњавати. 

Са леве стране у одељку Folders видимо организацију фасцикли у које се смешта 
одговарајућа порука, при чему су стандардни делови испод Local Folders, а остале 
корисник прави по својој жељи (у овом примеру то је фолдер Posao KPA). Када се 
направи нова порука и изабере команда Send она поруку смешта у фолдер Outbox, 

Направи нову 
поруку 

Одговори (свима 
All) на поруку 

Проследи 
даље поруку 

Одштампај 

Прими и 
пошаљи 
поруке 
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одакле се на одредиште шаље по избору команде Send/Recv (Send/Receive). По 
извршењу те команде порука се пребацује у фолдер Sent Items тако да имамо траг о 
послатим порукама. У фолдер Inbox смештају се примљене поруке, а у фолдер 
Deleted Items поруке које смо избрисали. Drafts је ознака фолдера у који се 
смештају недовршене поруке (поруке у припреми).  

Испод се налази адресар (Contacts) у који се уносе електронске адресе и остали 
идентификациони подаци особа којима желимо да шаљемо пошту. У десном делу je 
приказана листа порука за селектованни фолдер (у нашем случају то је фолдер 
Inbox), као и садржај селектоване поруке. Све делове, осим листе порука, можемо 
укључити и искључити командом View ► Layout.  

Нова порука се креира кликом на прву икону (Create Mail) или комбинацијом 
tastera Ctrl+N. Добија се прозор као на Слици 61 чије елементе ћемо укратко 
објаснити. 

 

 

  

Слика 61. Прозор за креирање поруке и припајање датотека Attachments 

1. поље To – у њега уносимо адресу примаоца у облику ime@domen (нпр. 
z.popovic@vts-zvecan.edu.rs, а пошто је прималац већ у адресару онда се не 
види његова адреса већ име из адресара као што је приказано на претходној 
слици). Знак @ се чита као »ет« (енглески at) и значи  »код«. Прималац не 
мора да буде само једна особа, већ се може унети више адреса раздвојених 
зарезим или тачка-зарезом.  

2. поље Cc (Carbon Copy) и Bcc (Blind Carbon Copy) – у које уписујемо адресу 
другог примаоца, при чему први прималац зна (Cc) или незна (Bcc) да је иста 
порука послата и другим лицима. 

3. поље Subject – намењено је кратком опису садржаја поруке  

4. Испод је поље за текст поруке и он се може форматизовати као у неком од 
програма за обраду текста.  

Постоји могућност да користите елктронску пошту и онда када немате ниједан 
програм за то, нити посебан налог код вашег Интернет провајдера (давалаца 
услуга). Чак код куће не морате имати ни рачунар. У том случају Интернету 
приступате са доступног рачунара (нпр. Из Интернет кафића), и користећи читаче 
Weba  отворите налг за пошту (најчешће бесплатно). Тренутно су најпопуларнији 

Пошаљи поруку  
проверa имена 
из Адресара 

припајање датотека 
Attachment  

 

Приоритет 
поруке Дигитални 

потпис и 
енкрипција 
поруке 

 
1
2
3 
 
 
 
4
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Yahoo mail, Hotmail, Gmail и др. У том случају се и програм и поштанско сандуче 
налазе на серверу организације која нуди приступ електронској пошти преко Weba, 
па вам је једино потребно да запамтите своје корисничко име и лозинку и моћи ћете 
свом налогу приступити са било ког рачунара и из било ког читача  Weba  широм 
света. Овај тренд у коришћењу електронске поште, назван Web Mail, све више 
подржавају и комерцијални Интернет провајдери, тако да вам нуде и ову погодност 
ако се одлучите да код њих отворите налог.  

Ако немате свој налог отворите га и пошаљите поруку типа: 

 

Име и презиме 

Енергетика или Менаџмент у електротехници 

Број индекса 

 

На електронску пошту професора. 
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Одговори на питања: 

1) Шта је E-mail? 

2) Електронска пошта обавезно садржи: 
a) адресу примаоца и текст поруке 
b) текст поруке и потпис пошиљаоца 
c) предмет поруке и потпис пошиљаоца. 

3) e-mail адреса корисника je y облику: 
a) имекорисника*имесервера 
b) имесервера@имекорисника 
c) имекорисника@имесервера 

4) Шта је Outlook Express?______________________________________________ 

5) Шта значе скраћенице From, To, Cc, Bcc? 
___________________________________________________________________ 

6) Каталог „сандуче" са приспелом поштом зове се: 
a) Outbox 
b) Inbox 
c) Drafts. 

7) Шта је Attachment?__________________________________________________ 

8) Пошта у припреми смештена je y каталогу: 
a) Outbox 
b) Sent Items 
c) Drafts. 

9) Активирањем алатке New Mail: 
a) креирате нову пошту 
b) примате приспелу пошту 
c) шаљете пошту. 

10)  Шта нам омогућава опција Replay to sender? 
a) Пријем E-mail-a 
b) Брисање примљене поруке 
c) Одговор на примљену пошту 

11)  Копије свих порука које шаљете чувају се у фолдеру: 
a) Inbox 
b) Drafts. 
c) Outbox 
d) Sent Items 


